Copyright Statement

GD Han’s Yueming Laser Group co., Ltd.
All rights reserved.

GD Han’s Yueming Laser Group co., Ltd (Han’s Yueming Laser hereafter) reserves the right to modify the products and product specifications described in this manual without advance notice.

Han’s Yueming Laser is not responsible to any direct, indirect, or consequential damage or liability caused by improper use of this manual or the product.

Han’s Yueming Laser owns the patent, copyright or any other intellectual property right of this product and the related software. No one shall duplicate, reproduce, process or use this product and its parts, unless authorized by Han’s Yueming Laser.

All the name referred in this manual only for identification, if belongs to other company’s registered trademark or copyright, proprietary rights of the name belongs to their respective holder.
Foreword

Thanks for purchasing the laser engraving machine control system of our company. Before operating, please read this manual carefully to ensure proper operation. Please keep the manual properly for reference. Since the configs are different, certain models do not have the functions listed in this manual. Please refer to the specific functions for details.

Due to the constantly tech update, the specification for reference only, subject to the real standard.

Tags in this book:

<table>
<thead>
<tr>
<th>![Alarm]</th>
<th>Special Attention: User must follow and perform as the manual, otherwise, it could lead to errors or relatively serious problem.</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Note]</td>
<td>Note: User should comply with the attention and suggestion in this manual; it could bring much easier operation.</td>
</tr>
</tbody>
</table>
Contents

Copyright Statement ........................................................................................................................................... 2
Foreword ............................................................................................................................................................. 1
Contents ........................................................................................................................................................... 1
Chapter 1 Software Introduction .................................................................................................................... 1
  1.1 Software Introduction ....................................................................................................................... 1
  1.2 Software Installation ......................................................................................................................... 2
    1.2.1 Installation Requirements ........................................................................................................... 2
    1.2.2 Edition Introduction .................................................................................................................... 2
    1.2.3 Drive Installation .......................................................................................................................... 3
    1.2.4 SmartCarve4 Installation ............................................................................................................. 3
  1.3 SmartCarve4 Uninstallation .................................................................................................................. 6
  1.4 Operational Flowchart ....................................................................................................................... 8
Chapter 2 Software Application ..................................................................................................................... 9
  2.1 Software Interface .............................................................................................................................. 9
    2.1.1 Menu bar ..................................................................................................................................... 10
      2.1.1.1 File (F) ................................................................................................................................. 10
      2.1.1.1.1 New .................................................................................................................................. 11
      2.1.1.1.2 Open ............................................................................................................................... 11
      2.1.1.1.3 Close ............................................................................................................................. 11
      2.1.1.1.4 Save ............................................................................................................................ 12
      2.1.1.1.5 Save as ......................................................................................................................... 12
      2.1.1.1.6 Import File ...................................................................................................................... 12
      2.1.1.1.7 Import File to Lib ............................................................................................................ 13
      2.1.1.1.8 Import from Scanner ....................................................................................................... 14
      2.1.1.1.9 Export File ..................................................................................................................... 14
      2.1.1.1.10 Carver Out ................................................................................................................... 15
      2.1.1.1.11 Net Transfer ................................................................................................................. 16
2.1.1.12 Exit .............................................................................................. 16
2.1.1.2 Edit (E) ............................................................................................ 16
2.1.1.3 Draw (D) ........................................................................................... 17
2.1.1.4 Modify (M) ......................................................................................... 18
2.1.1.5 View (V) ............................................................................................ 19
2.1.1.6 Tools (T) ........................................................................................... 20
2.1.1.7 Window (W) ....................................................................................... 20
2.1.1.8 Help (H) ............................................................................................ 20

2.1.2 System Toolbar ..................................................................................... 21

2.1.2.1 Main Toolbar ..................................................................................... 21
2.1.2.2 View Toolbar ..................................................................................... 21
2.1.2.3 Graph Modify Toolbar ...................................................................... 22
2.1.2.4 Machine Toolbar .............................................................................. 22
2.1.2.5 Drawing Toolbar .............................................................................. 22
2.1.2.6 Alignment Toolbar .......................................................................... 23
2.1.2.7 Bezier Toolbar .................................................................................. 23

2.1.3 Status Bar ............................................................................................. 23

2.2 Software Operation .................................................................................. 23

2.2.1 File ....................................................................................................... 23

2.2.1.1 Save and Open SMC Files ................................................................. 23
2.2.1.2 Import Picture .................................................................................... 26
2.2.1.3 Import Vector File ............................................................................ 29
2.2.1.4 Import from scanner ....................................................................... 39
2.2.1.5 Export File ....................................................................................... 41
2.2.1.6 Graph Library .................................................................................. 45

2.2.1.6.1 Advanced features of the graph library ..................................... 48

2.2.2 Drawing and Graph Attribute ............................................................. 53

2.2.2.1 Graph Selection .............................................................................. 53
2.2.2.2 Object List Operation .................................................................... 55
2.2.2.3 Graph Node Editing .................................................................................... 55
2.2.2.4 Line ............................................................................................................. 56
2.2.2.5 Rectangle .................................................................................................... 59
2.2.2.6 Regular Polygon .......................................................................................... 61
2.2.2.7 Ellipse ......................................................................................................... 61
2.2.2.8 Bézier Curve1 ............................................................................................. 63
2.2.2.9 Bézier Curve2 ............................................................................................. 64
2.2.2.10 Text ..................................................................................................... 68
2.2.2.11 Drill ..................................................................................................... 70
2.2.3 Edit ................................................................................................................ 71
2.2.3.1 Copy (Shortcut: CTRL+C)............................................................................. 71
2.2.3.2 Delete (Shortcut: Delete)............................................................................ 71
2.2.3.3 Cut (Shortcut: CTRT+X) ............................................................................... 72
2.2.3.4 Paste (Shortcut: CTRL+V)............................................................................ 72
2.2.3.5 Cut Out (Shortcut: CTRL+U)........................................................................ 72
2.2.3.6 Clone........................................................................................................... 74
2.2.3.7 Undo (Shortcut: Ctrl + Z) ............................................................................ 75
2.2.3.8 Re-do (Shortcut: Ctrl + Y)............................................................................ 75
2.2.3.9 Alignment ................................................................................................... 76
2.2.3.10 Prev. Graph ......................................................................................... 80
2.2.3.11 Next Graph ......................................................................................... 80
2.2.3.12 Snap Graph ......................................................................................... 80
2.2.4 Modify ........................................................................................................... 81
2.2.4.1 Mirror ......................................................................................................... 81
2.2.4.2 Fill ............................................................................................................... 82
2.2.4.3 Coordinate .................................................................................................. 83
2.2.4.4 Close Curve ................................................................................................. 84
2.2.4.5 Link Line ...................................................................................................... 85
2.2.4.6 Convert Line ............................................................................................... 85
2.2.4.7 Convert Dashed ................................................................. 86
2.2.4.8 Curve Starting Point and Direction ........................................ 88
2.2.4.9 Shrink and Expand ............................................................. 89
2.2.4.10 Leadin /Lead out Line ...................................................... 92
2.2.4.11 Set Curve Precision .......................................................... 94
2.2.4.12 Optimize Path ................................................................. 95
2.2.4.13 Convert Drill to Small Circle ............................................. 103
2.2.4.14 Convert Small Graph to Drill ............................................ 103
2.2.4.15 Group/Scatter ................................................................. 104
2.2.4.16 Convert Array and Leftover ............................................. 107
2.2.4.17 Convert to Light Guide .................................................... 117
2.2.4.18 Find Overlap Line ............................................................ 117
2.2.4.19 Catch Edge ................................................................. 119

2.2.5 Switch ....................................................................................... 121
2.2.5.1 Move .............................................................................. 121
2.2.5.2 Rotate ............................................................................ 123
2.2.5.3 Mirror ............................................................................ 126
2.2.5.4 Stretch .......................................................................... 128
2.2.5.5 Shear ............................................................................ 130

2.2.6 Layer ....................................................................................... 132
2.2.6.1 Layer List ........................................................................ 132
2.2.6.2 Parameter Library ............................................................ 134
2.2.6.3 Layer Parameters ............................................................. 134
2.2.6.4 Work Parameters ............................................................. 134

2.2.7 Virtual Printer Input ............................................................... 135

2.2.8 Export ...................................................................................... 136
2.2.8.1 Net Transfer ..................................................................... 136
2.2.8.2 Carve Output ................................................................. 137
2.2.8.3 Jog Control ................................................................. 139
2.2.8.4 Cancel Filter Operation ................................................................. 140
2.2.8.5 Machine Parameter Setting ......................................................... 141
2.2.8.6 Path Simulation ............................................................................. 141

2.2.9 Config .................................................................................................. 142
  2.2.9.1 General .......................................................................................... 142
  2.2.9.2 Color ............................................................................................... 143
  2.2.9.3 Workspace ...................................................................................... 145
  2.2.9.4 AutoSave ........................................................................................ 145
  2.2.9.5 Move/Rotate ................................................................................... 146
  2.2.9.6 Precision ......................................................................................... 147
  2.2.9.7 User Manager .................................................................................. 148
  2.2.9.8 Backlash ........................................................................................ 149

2.2.10 Language ........................................................................................... 150
  2.2.10.1 Language Setting .......................................................................... 150
  2.2.10.2 Translate Tool ............................................................................... 152

Chapter 3 Application Example ............................................................................. 153
  3.1 Drawing Light Guide Graphics ............................................................... 153
    3.1.1 Light Guide1 ...................................................................................... 155
      3.1.1.1 Line ............................................................................................... 155
      3.1.1.2 Sweep ........................................................................................... 159
      3.1.1.3 Grid .............................................................................................. 164
      3.1.1.4 Circle ............................................................................................ 168
      3.1.1.5 Drawing Anomalistic Light Guide ................................................... 169
    3.1.2 Light Guide 2 ...................................................................................... 171
      3.1.2.1 Line ............................................................................................... 174
      3.1.2.2 Sweep ........................................................................................... 179
      3.1.2.3 Grid .............................................................................................. 182
      3.1.2.4 Circle ............................................................................................ 185
    3.1.3 Support and Optimize GTools ............................................................. 185
Chapter 1  Software Introduction

1.1 Software Introduction

SmartCarve4 series software is a fire-new software which designed by GD Han’s Yueming Laser Group. Co. Ltd. Support process control create data of a majority of laser equipments. With computer aided design(CAD), computer intelligent control, graphics processing, multi-data formats import, multi-craftwork of laser processing, multi-layer setting and support many languages. Introductions follow:

- CAD functions, including the drawing and editing of point, line, rectangle, polygon, circular arc, ellipse, Bezier curve, text, etc. node editing is supported, allowing users to adjust the graphics precisely in a more convenient way; it also supports advanced graphical editing such as moving, rotating, mirroring, stretching, shearing, aligning, cloning, filling and gray level adjust.
- Supporting to import data in plt, dxf, dst, dsb, ai, nc, bmp, jpg, gif, out, oux, ymd, yln, cut, smc etc. formats.
- Providing simple graphics processing. Including move, rotate, mirror, stretch, shear, align and clone the vector figure and bitmap. Supporting the net dealing, invert dealing and gray level adjust of bitmap.
- Capable of modifying the starting point and direction of cutting of graphics, and multi-node editing.
- Capable of closed modification of curve and curve clipping.
- Providing ruler showing, easy to know clearly about the figure size and position.
- Providing several manners of viewing figures, such as zoom in, zoom out, etc.
- Supporting many languages. SmartCarve 4 series software support Unicode, it support all the languages in theory. Make the xml file for the standard format, easy to modify the language. The default languages are Chinese (Simplified), Chinese (Traditional) and English. Users can increase or decrease and modify language if need.
- Supporting as many as 256 processing layers; Users can set the processing parameters for the different layers and the priority of processing layers according to the requirements of processing.
- Supporting many kinds of motion controllers; including No.1 controller, No.3 controller, No.4 controller. Not only support cutting machine, but also support vision machine, feeding machine, marker, etc. Processing data can be saved as *.oux (YUEMING No.1 .1 controller) file or *.ymd (YUEMING Third Controller) file and downloaded to the machine.
- Capable of saving all figures and processing parameters of the current project.
- With YUEMING virtual printer input function. Input the figure to SmartCarve4 to process through virtual printer.
- Supporting graphics layout and edge layout with dual laser heads.
- Supporting as many as 256 times of undo and re-do operations.
- Providing shrink and expand feature for curve zoom edit.
- Supporting to draw and edit the leadin and lead out line.
- Capable of compensation of closed curve.
- Supporting small graphics to drill and drill to small circle features.
- Providing advanced layout in array way.
Supporting curve line data smoothing feature.

Providing a function to optimize the path of cutting data.

With figure track simulation function.

With light guide function. Easy to create the process data of light guide.

1.2 Software Installation

1.2.1 Installation Requirements

Operating system: Windows 2000/XP/vista/win7 (32bits or 64bits)

PC:

CPU: >1GHz
Memory: > 1GB

1.2.2 Edition Introduction

Fig. 1-1

SmartCarve 4 series have the following editions:

- **SmartCarve4.1**: the first edition of SmartCarve4 series, only used for machine with No.1 controller.
- **SmartCarve4.2**: base on SmartCarve4.1, support No.1.1 controller, No.3 controller, No.4 controller and vision cutting machine.
- **SmartCarve4.3**: base on SmartCarve4.2, improved the capability and function, it can replace the SmartCarve4.2.
- **SmartVision**: the software which the vision cutting machine (SM960) used, based on SmartCarve4.1, stop using now.
- **SmartScanner**: the software which laser marker machine used, based on SmartCarve4.3, it will be introduced in marker software manual.

**Alarm**

- No.1 controller can only use SmartCarve4.1; No.1.1 controller must use SmartCarve4.2 and the above version software.
- Our company will not update the software which stop to using, but we still have the software copyright.
Different edition has different function and capability, this manual default use SmartCarve4.3 to introduce.

Note
Update and support the software is a continually way. We will release the new software through the website of our company. Users can acquire the update information and download the new software from our website.

1.2.3 Drive Installation

Different machine has different controller, some controller needs install the driver to work.

- **1st Controller**
  Need install the USB device driver, please read the “HAN'S YM User Manual of NO.1.1 Control System”.

- **3rd Controller**
  No driver is required.

- **4th Controller(PCI)**
  Need install the PCI card driver, please read the “HAN'S YM User Manual of 4th Control System”.

- **Vision Machine**
  Need install the PCI card driver and the camera driver, please read the “HAN'S YM User Manual of Machine Vision System”.

- **NestCutting(PCI)**
  Need install the PCI card driver, please read the “Han's YM User Manual of NestCutting”.

- **Marker**
  Need install the laser marker controller driver.

1.2.4 SmartCarve4 Installation

1) Insert the soft CD into CD-ROM (or hard drive), find the SmartCarveInstall4.X.XX.exe and double click it, and then the following dialogue box will show up:

![Fig. 1-2](image)
Select your language, then click “OK”:

![Progress Bar]

Please wait while Setup is loading…
unpacking data: 81%

**Fig. 1-3**

2) Please wait till the system enters the following welcome interface:

![Welcome Interface]

**Fig. 1-4**

3) Click “Next”:

![Install Wizard]

**Fig. 1-5**

4) Click “Browse” to locate the path of the target folder, and click “Install”:
5) Wait for the final prompt for completion:

![Fig. 1-6](image1)

6) After the installation, a shortcut icon of SmartCarve4 will be displayed on the Windows desktop. Users can double click this icon for execution or select “Run SmartCarve4.3” upon completion of installation to run the software. And the following dialog box pops up:

![Fig. 1-7](image2)
Select the current language in the “Software Language” item, and select your required machine type in “Machine type”. Then, click “OK” to start the software.

Softdog is required upon the initial use. If the soft can’t check the correct softdog, user can’t use this software, and the follow warm dialog will be shown:

![SmartCarve4 Uninstallation](image)

1.3 SmartCarve4 Uninstallation

1) Click “Start” → “All Programs” → “SmartCarve4.3” → “Uninstall”, the dialogue shows up:
2) Click “Next”, the following dialogue box will show up as soon as the progress bar completes:

![Fig. 1-10](image)

3) Wait till the following dialogue box shows up upon completion:

![Fig. 1-11](image)

4) Click “Finish” to complete.
1.4 Operational Flowchart

Fig. 1-13 Operational flowchart
Chapter 2  Software Application

2.1 Software Interface

Fig. 2-1  Main interface

① System toolbar  ② Other toolbar  ③ Graphics list  ④ Graphic property setting
⑤ Drawing toolbar  ⑥ Graphic private property setting  ⑦ Alignment toolbar
⑧ Layer list  ⑨ Layer parameter  ⑩ Drawing area

Fig. 2-2  Drawing Area
Interface description:

**System toolbar**: It includes such functions as New, Open, Save, Cut, Copy, Paste, Cut out, Undo, Redo, Zoom Window, Move and View.

**Graphics list box**: It shows all graphics list included in the drawing area.

**Graphics property settings**: Set the property of graphics, such as position, size, etc.

**Drawing toolbar**: Capable of drawing basic graphics such as line, rectangle, circle, etc. Import of all formats of figure and analog printing are supported.

**Layer list**: It shows 256 layers and the cutting sequence.

**Setting area of layer parameters**: Set the layer parameters and processing parameters.

**Description of layer parameters**: Describe details of all parameters in the layer

**Alignment toolbar**: When a figure is selected, you can use the tool to arrange the position of this figure.

**Other toolbar**: editing and modifying figure, net transfer and machine setting.

**Drawing area**: It is an area for drawing and editing figure.

> User can click key on the dialogue box of graphics list or layer list to hide or display it at any side of the screen.

### 2.1.1 Menu bar

The menu bar after clicking “New”:

![Menu bar](Fig. 2-3)

#### 2.1.1.1 File (F)

![Menu bar](Fig. 2-4)
2.1.1.1.1  New

Select “File”→“New” option, or click the icon of the toolbar, or press “CTRL+N” to create a new document.

2.1.1.1.2  Open

Select “File”→“Open” option, or click the icon of the toolbar, or press “CTRL+O” to open a document, only support “*.smc” document.

Open the dialog box as figure 2-5, the file list will show the smc file of current file folder. You can tick the “show preview” button, and then select an smc file in the file list, the figure will shown at the preview area.

![Fig. 2-5](image)

**Smc file instruction:**

Smc is a file format which defined by our company, it mainly used to save the drawing figure, layer parameter, machine parameter, system parameter, etc.

If you software has error, you can saved it to smc file, and then send it to us, we will know all the instance and solve it quickly.

2.1.1.1.3  Close

Select “File”→”Close” option, or press “Ctrl+F4” to close the current document. If the document has been modified and haven’t been saved, the system will pop up a dialog box to prompt you whether to save the modified content.
2.1.1.1.4 Save

Select “File” → “Save” option, or click the icon of the toolbar, or press “Ctrl+S” to save the current document, if it is a new document, the system will pop up a save as dialog box, save the document as local file folder.

2.1.1.1.5 Save as

Select “File” → “Save as” option to save the project file as another file path. If it is a new document, a dialog box will pop up as figure 2-7:

![](Fig. 2-7)

2.1.1.1.6 Import File

Select “File” → “Import file” option, a dialog box will pop up, you can import graphics file of all kindsof support formats. You can tick the “show preview” button, and then select an smc file in the file list, the graphics will shown at the preview area. You can’t modify the graphics file if you tick the “read only”. As figure 2-8: (please refer to 2.2.1.2, 2.2.1.3 and 2.2.1.4)
2.1.1.1.7 Import File to Lib

Select “File”→”Import file to lib” option, or press “Ctrl+L”, import file dialog box will pop up, only support to import two file format “*.plt” and “*.dxf”, as figure 2-9:

- The ai format supports Adobe Illustrator 5.0~Adobe Illustrator 8.0 for this moment.
- The method of importing *.out file supported by No.1 controller is the same as that of importing *.ymd file, which is supported by Yueming 3rd Controller.
- *.yln file is generated by HAN’S YUEMING Camera Scan& Layout System, and user can import this kind of file directly.

Note

- The ai format supports Adobe Illustrator 5.0~Adobe Illustrator 8.0 for this moment.
Import graphics file to graphics library directly through import file. Graphics library is supported by this software for saving the graphics in common use, you can take it from graphics library directly when you want to use. Please refer to “graphics library” section for more detail.

2.1.1.1.8 Import from Scanner

Select “File”→”Import” from scanner option, you can import graphics to document from the scanner. (please refer to section 2.2.1.4 for more detail)

2.1.1.1.9 Export File

Select “File”→”Export file” option, or click the icon of toolbar, a dialog box will pop up, you can save the current graphics as the format of *.nc,*.plt,* .ymd,* .oux,* .Emd (* .oux is the export format of No.1 controller, * .ymd is the format of other controller, * .Emd is the file format of Em controller). As figure2-10:
2.1.1.1.10 Carver Out

Select “File” → “Carver out” option, carver out dialog box will pop up as the following figure, please refer to 2.2.8.2 for more detail.
2.1.1.11 Net Transfer

Select “File”→“net transfer” option, or click the icon of toolbar, a dialog box will pop up as figure 2-12: (only available for Third controller, transfer or manage the data via Ethernet, please refer to section 2.2.8.1 for more detail)

![Net Transfer dialog box](image)

Fig. 2-12

2.1.1.12 Exit

Select “File”→“Exit” option, or click the close icon at the top right corner to exit process. If the document has been modified, a dialog box will pop up as figure 2-6, prompt whether save the modified data to document.

2.1.2 Edit (E)
Undo (Cancel the current operation and return to the previous state)
Redo (Resume the previous undo operation)
Delete (Delete the selected graphics)
Copy (Copy the selected graphics)
Cut (Cut the selected graphics)
Paste (Paste the graphics that is previously copied or cut)
Cut out (Clip the curve)
Clone (Array copy for the selected graphics)
Add graph to lib (Add selected graphics to the graph library)
Prev Graph (Select the previous graph)
Next Graph (Select the next graph)
Curve Edit (Modify the bezier2 graphics by transition shaply, smoothly, symmtrically)

2.1.1.3 Draw (D)

Pick (Select the graphics function)
Edit node (Edit the node of graph)
Line (Draw a line)
Rectangle (Draw a rectangle)
Regular polygon (draw a regular polygon)
Ellipse (Draw a circle or an ellipse)
Bézier curve (Draw a Bézier curve)
Text (Draw letters or characters)
Drill (Draw a drill graph (point))
Bitmap file (Import image files of different formats such as BMP, JPG, etc.)
Vector file (Import vector files of PLT, DXF, DST, DSB, AI, out,oux, cut, nc, yln or ymd format)
2.1.1.4 Modify (M)

Mirror (Perform mirror function at X or Y direction on the selected graphics)
Fill (Fill in the closed curve)
Coordinate (Set the system coordinate)
Convert Line (Transfer the graphics to curves)
Convert Dashed (Transfer the graphics to dashed curves)
Optimize Path (Optimize the cut path)
Shrink and Expand (Shrink or expand the curves)
Add Lead (Add leadin or lead out line)
Set Curve Precision (Set the curve processing precision)
Link Line (Link multi-line to one line)
Close Curve (Make the curves closed)
Drill to small circle (Transfer drill graphics to small circle)
Small graph to drill (Transfer small circle to drill graphics)
Group (Group multi-graphics to a group)
Scatter Group (Scatter a group to multi-graphics)
Convert Array (Convert the selected graphics to array)
Scatter Array (Scatter array to many unattached graphics)
Convert Leftover (Convert the selected graphics to the leftover of array graphics)
Detach Leftover (Detach the leftover graph from array graph)
Convert to light guide (convert the close graphics to light guide graphics to enter parametersetting interface, realize linear grads change)
Convert to light guide:convert the close graphics to light guide graphics to enter parametersetting interface, realize non-linear grads change.

Find overlap line:according to the setting precision, find out overlap line, you can also delect it.

### 2.1.1.5 View (V)

#### Fig. 2-16

<table>
<thead>
<tr>
<th>View</th>
<th>Tools</th>
<th>Windows</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Ruler</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Switch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Layer List</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Graph List</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Tree List</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphic library</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Toolbar</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard view</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ Snap Graph</td>
<td></td>
<td></td>
<td>CTRL+P</td>
</tr>
</tbody>
</table>

Grid (Show or hide the background grid in drawing area)

Ruler: (Show or hide ruler in drawing area)

Switch: (Show or hide the interface of switch dialogue)

Layer List: (Show or hide the interface of layer setting)

Graph List: (Show or hide the interface of graphics list and attribute)

Tree List: (Show or hide the graphics list tree)

Graph library: (Show or hide the interface of graph library)

Toolbar: (Show or hide the main toolbar, edit toolbar, draw toolbar, bezier toolbar, etc.)

Control bar: (Show or hide the control panel, only available for 4th controller or vision machine)

Vision bar: (Show or hide the vision panel, only available for vision machine)

Standard view: (Resume the software interface to the default status)

Snap Graph: (Whether to snap the graph node on drawing or editing)
2.1.1.6 Tools (T)

<table>
<thead>
<tr>
<th>Tools (T)</th>
<th>Windows (W)</th>
<th>Help (H)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language (L)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Machine (M)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Machine Setting (S)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jog Control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Config (C)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fig. 2-17  Left side is No.1 controller interface, the right side is No.3/4 controller interface

Language (Many languages are available)

machine (select the controller or machine type)

unit (metric or British, the unit type when the software use to show the coordinate, distance)

machine settings(Set the related system parameters of device according to the selected machine type)

jog control (Only available for No.1.1 controller, to control the machine move or laser test)

config (config parameters of this software)

2.1.1.7 Window (W)

<table>
<thead>
<tr>
<th>Windows (W)</th>
<th>Help (H)</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window (N)</td>
<td></td>
</tr>
<tr>
<td>Cascade (C)</td>
<td></td>
</tr>
<tr>
<td>Tile Horizontally (H)</td>
<td></td>
</tr>
<tr>
<td>Tile Verticaly (V)</td>
<td></td>
</tr>
</tbody>
</table>

Fig. 2-18

New window(Create a new window in the current document)

Cascade (Stack up all windows one by one)

Tile horizontally (Place all windows by column)

Tile Vertically (Place all windows by row)

As well as all names of created windows in the software (select as required)

2.1.1.8 Help (H)

<table>
<thead>
<tr>
<th>Help (H)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
<tr>
<td>Help/Controller</td>
<td>F12</td>
</tr>
<tr>
<td>About (A)</td>
<td></td>
</tr>
</tbody>
</table>
Fig. 2-19

Helps (SmartCarve user manual)
Help/Controller (User can view the manual of current used controller)
About (Software version and copyright statement)

2.1.2 System Toolbar

2.1.2.1 Main Toolbar

Function: New, Open, Save, Cut, Copy, Paste, Cut out, Undo, and Re-do.

2.1.2.2 View Toolbar

Function: It is used to switch the drawing window and view the details of figure in the drawing area.

Zoom Window: By clicking this button, you can then press the left key of the mouse in drawing area to zoom in the figure or the right key to zoom out the figure.

Zoom Pan: You can move the view in the drawing area by clicking this button, or by pressing the middle key of the mouse.

Zoom in: By clicking this button, you can zoom in figure in the drawing area.

Zoom out: By clicking this button, you can zoom out figure in the drawing area.

Zoom all: By clicking this button, you can display all drafted figures in the drawing area.

Zoom Area: Press and hold the left key of mouse to draw a rectangle, and the system will zoom in the selected area.

View WorkSpace: clicking this button, you can display the entire work area in the drawing area.
2.1.2.3 Graph Modify Toolbar

Fig. 2-22

Function: **Group, Scatter, Convert Array, Scatter Array, Fill, Shrink** and Expand, **Add Leadin/Lead out line**, and **Close Curve**.

2.1.2.4 Machine Toolbar

Fig. 2-23

Function: Network transmission, undo some operations (such as cancel the printer input status), export file, carve output, Machine setting, and track simulation.

2.1.2.5 Drawing Toolbar

Fig. 2-24

Function: Graph selection, node edit, line, rectangle, regular polygon, ellipse, bezier curve, bezier2 curve, text, picture import and vector graph import.

For details, please refer to 2.2.2Figure Drawing and Attribute Settings.
2.1.2.6 Alignment Toolbar

![Alignment Toolbar](image)

Function: Move to origin, align to left, align to right, align to top, align to bottom, align to center, same width, same height, same size, horizon evenly, and vertical evenly; for details, please refer to 2.2.3.9 Alignment.

2.1.2.7 Bezier Toolbar

![Bezier Toolbar](image)

Function: transition sharply, transition smoothly, transition symmetrically. For more details, please refer to 2.2.2.9 Bezier curve.

2.1.3 Status Bar

The bottom position of the software interface:

![Status Bar](image)

- **Progress bar**: It shows the progress when processing data.
- **Cursor coordinate**: It shows the real-time coordinate of cursor. The unit is mm.

2.2 Software Operation

2.2.1 File

The system supports graphics files of many formats: plt, dxf, ai, cut, nc, dst, dsb, jpg, bmp, out, oux, ymd, yln, smc, etc.

2.2.1.1 Save and Open SMC Files

The SMC file is used to save the project, include parameters, graphics, processing data, and system parameters for the current project.

- **Save SMC files**
Open SmartCarve4, create a new file and edit it. Then click `button or press “CTRL+S”, the following dialogue box will show up:

![Save As Dialogue Box](image)

Input file name, and then click “save”.

- **Open SMC files**

  Open SmartCarve4 and click ` in the toolbar, if select “show preview” it will show the file graphics in the preview area as the following figure:

![Open Dialogue Box](image)

Select a project file of *.smc format, such as test.smc in the above picture, and double click it to open.
When open the SMC file, the machine type must be the same as the saved file, or it cannot be opened. The following dialog will show up:

![SmartCarve dialog](image)

**Fig. 2-31**

- **Importing SMC**

  Click the Import vector graph button in the drawing toolbar or press CTRL+2 to pop up the dialog box to open a file. Select “Smc Files (*.smc)” in the dropdown list, choose the corresponding SMC file, and click to open it.
The import of SMC file only enables the graphics data to be imported instead of the parameters in the file, so there is no need to set the same machine type during the import.

2.2.1.2 Import Picture

**Import Picture:** After clicking the button, click the button in drawing toolbar as shown in the following dialogue box will then show up:

Select the file type (BMP or JPG, etc) and find the file to be opened from the dialogue box, and then double click it to open it. As a default, the system will change the open picture to 256 gray level bitmap.
**Bmp Property:** Select the picture and the bitmap attribute area will show the private attribute where user can set the different values to adjust the selected picture.

![Bmp Property](image)

**Gray level:** Regarding the color grade, 2, 4, 8, 16, 32, 64, 128, or 256-color is supported. The lower the color grade is, the more distorted the picture would be. The system default is 256-color.

![Gray level](image)

**Net:** Select this option and click “Apply”, and the picture will be changed to a net dot picture with only black and white colors as follows:

![Net](image)
Invert: Reverse the color of each pixel in the picture. In the picture, the black part is resulting from laser giving out light when the machine is carving, while the white part is because the laser does not give out light.

**Y Scan Interval (mm):** The space between two pixels at Y direction, the unit is mm. Its default value is the same as the picture’s resolution of Y direction (DPI Y).

**X Scan Interval (mm):** The space between two pixels at X direction, the unit is mm. Its default value is the same as the picture’s resolution of X direction (DPI X).

**Ascent (mm):** If a value is set here, the edge of carved figure would then have gradient. Generally, the gradient is started from the periphery of line. The smaller the value is, the steeper the gradient would be. There is no gradient when the value is 0.

**Sweep direction:** Set the engrave direction of carving processing.

X single sweep means the laser goes from left to right (or right to left) every time when scanning, and after scanning a line, it is closed and return to the left (or right) of the next line to go on scanning.

X double sweep means the laser goes from left to right (or right to left) when scanning, and after scanning a line, it jumps to the right (or left) of the next line and starts scanning again. It repeats this operation until the end of the scanning.

Y single sweep means the laser goes from up to down (or down to up) every time when scanning, and after scanning a column, it is closed and returned to the top (or bottom) of the next line and go on scanning.
Y double sweep means that the laser goes from up to down (or down to up) when scanning, and after scanning a column, it jumps to the bottom (or top) of the next line and starts scanning again. It repeats this operation until the end of the scanning.

2.2.1.3 Import Vector File

Import Vector File: Take Corel DRAW X3 as an example. Open Corel DRAW X3 and draw a figure:

After that, click “File” -> “Export” from the menu bar, and a dialogue box shows up:
Save the figure as “PLT-HPGL Plotter File”. Enter the file name and click “Export”, a dialogue box as below shows up:

Note that in “Page” option, the graph plotter unit is set as “1016”. It could also be set as other values; however, the same value should be chosen when SmartCarve4 is importing later.

In “Advanced” option, the small the “Curve resolution” is, the better the curve precision would be. Other parameters could be set as defaults.
Importing into SmartCarve4: Click the button in the drawing toolbar to import the vector diagram, and the following dialogue box will show up:

Select PLT (*.plt) in file type, and select the required PLT file to open.

The following dialogue box will then show up:
Resolution: 1000 DPI, 1016 DPI, and others (Input DPI manually) are available.

Usually, the DPI should be set as the same as that of original drawing when the PLT file is importing.

The default value is 1016 DPI. Click OK to import the file, and the interface is shown as follows:

- Import AI file: open CorelDRAW and draw figure:
Click the “File” → “Export” in the menu bar after drawing; dialog box pops up as follow:

Select AI- Adobe Illustrator for the saving type, click export, a dialog box will pop up as follow:
Select by the red pane, click “OK” to export file. Then start SmartCarve, click the icon of the drawing toolbar to import the file.

Open the document, import it to SmartCarve, the setting dialog box will pop up, setting as follow:
The import effect is as the following figure:

 Fig. 2-52

 ➢ Import dxf file:

 Take AutoCAD 2012 for example, start the software, make sure the consistency of unit before drawing, select the format of main menu ->unit, set mm for the unit;
after finished, click “File”→“Save as” to open save as dialog box, select AutoCAD 2004/LT2004 DXF format;
Then enter SmartCarve4, import the saved DXF file just now; select draw-> vector file, or press "Ctrl+2", or click the icon, a dialog box pops up as follow. If the data mount of document is large, you need to wait a moment; it will show at the preview area after read the data;

Select the DXF file which need to import, and click open, a dialog box will pop up:
Show Text: tick this item, the text information of document will be shown.

Drawing units: the length unit of drawing graphics in the document, the default is mm.

Gerber dxf format: tick this item, it can identify the dxf format which exported from marker making of Gerber company; if it is other format, please do not tick this item, otherwise the document hasn’t been opened.

Divide by layer: tick this item, according to the different layer of dxf file to carve up layer; if do not tick this item; it will carve up layer by the color of dxf file.

Convert point to drill: after tick “enable”, the “delay time” option would be activated, the imported point graphics will convert to drill; set the delay time to adjust laser drill time.

The opened graphics is as follow:

![Fig. 2-59](image-url)
2.2.1.4 Import from scanner

“Import from scanner” supports to import the bitmap file from scanner. Take EPSON scanner to import graphics for example as follow:

Select file-> import from scanner, the setting dialog box of scanner will pop up as follow:

![Fig. 2-60](image)

Choose the “Full Auto Mode”; click the “Customize” button, the following dialog box will pop up:

![Fig. 2-61](image)
Select the document type, click on the photograph/document, and then select the specify resolution for Full Auto Mode, set photograph/document resolution of 300dpi, click “OK” to back to the main interface, click on the “Scan” button, and wait for the scan as follows:

![Fig. 2-62](image)

Then the bitmap will be created in SmartCarve, the system default will convert the image to 256 gray scales as follows:

![Fig. 2-63](image)

About the bitmap property setting options, please refer to section 2.2.1.2.
2.2.1.5 Export File

- Exporting *.oux file

*.oux file is applicable to No.1.1 Controller.

The software is capable of saving the drafted figure as *.oux file. This file can be downloaded to the machine to allow off-line working.

After drafting the figures, click button in toolbar, and a dialogue box will show up as follows:

Enter the file name and click “Save”, a dialogue box will show up:

Here you can set all the output parameters of figures, such as how many lines or column is going to be replicated, origin mode, etc. Then, click “OK” to finish save file.

- Exporting *.plt file

The software is also capable of saving the drafted vector graphics as *.plt file.

Likewise, after drafting the figures, click button in toolbar, and a dialogue box will show up as follows:
Select “plt files (*.plt)” in “Save as type”, enter the file name and click “Save”, a dialogue box will pop up:

![Save As Dialogue Box](image)

Fig. 2-66

Select the resolution and click “OK” to finish save file.

![PLT File Export Dialogue Box](image)

Fig. 2-67

Now, three graphs of format cannot be saved as PLT format:

- Drill graph
- Fill graph
- Bitmap

**Note**

Exporting *.ymd file

*.ymd file is only applicable to HAN’S Yueming Third Controller.

With a config of Yueming Third Controller, the software is capable of exporting the figures as *.ymd files and downloading it to Yueming Third controller using the “Network transmission” function.

After drafting the figures, click button in toolbar, and a dialogue box will show up as follows:
Select the Data Type and click “OK” to save it as file of ymd format.

Select “Ymd Files(*.ymd)”, input document name and click “save”, the setting dialog box will pop up:

Array object: only export ARRAY object, do not export not array object; (this function is mainly used to electric double laser head process of No.3 controller).

Not array object: only export not array object, array object will be scattered automatic.

Cut length: set the Y direction length of current processing, it cannot exceed Y direction length of current machine breadth.

Intelligent cut: after tick this option, if the whole graphics has exceeded the current processing area and the Y direction length of this graphics less than current cut length, the software will achieve the function of processing the whole graphics automatically; if do not tick this option, the software will scattered automatic compulsively.

Take a simple example as follow, suppose the width of current processing area is 600mm, the height is 400mm, export the following graphics:
Export setting dialog box will pop up, set the length as 400mm (pay attention: do not exceed the current height of processing area);

Contrast tick intelligent cut and not tick intelligent cut:

![Export YML File dialog box](image)

- **Fig. 2-71 Not tick the intelligent cut option**

The surplus part would be processed next feeding.

- **Cutting graph**
- **Cutting point**
- **Primary graph**
Exporting *.nc file

Nc code also named G code, it is an international standard program code with CNC, often used to CNC machine. SmartCarve4 support to import and export this format file, mainly G00, G01, G02, G03, etc.

2.2.1.6 Graph Library

The library is provided for users to save graphics. Users can save common figures into it.

A. Import Files to Lib (CTRL+L)

In the menu bar, select “File”->”Import Files to Lib (CTRL+L)”, and a dialog box pops up:
The importable file formats are PLT and DXF. Select a file and open it. In the menu bar, click “View” → “Graph Lib”, and the opened figure is listed in the graph library.

**Note**

The default import type is “Overall import file”, when this option is chose, then the whole graphics of the plt or dxf file can be imported to the graphic library as a graphic unit. If this option isn’t chose, then the graphics of the plt or dxf file can be imported to the graphic library by separate. (If the file type is dxf file and the file have block, then the graphics of graphic library was named by the block name of the dxf file.)

User can right click the blank area of the graphic library to choose the “Overall import file” option.

**B. Add to Graph Lib (CTRL+I)**

- Pitch on one or more graphics (supported graphics to be added are: line, dashed, group, ellipse, regular polygon, Bezier, rectangle, bitmap, text).
- Click “Edit” → “Add to Graph Lib” in the menu, or use the shortcut CTRL+I or click “Add to Graph Lib” from the right-click menu to add the graphics to the library. A dialog pops up at the moment to prompt you to enter a name, as shown in the picture below:

After entering the name, click “Ok” or directly click “Ok” to add the graphics to the lib, as the following picture shows:
Users can edit the graphics in the lib by renaming, deleting the currently selected graphics, deleting all graphics or . Upon right clicking, a menu as shown below pops up:

The interface of graph library can be displayed horizontally or vertically.
Modify the figure name: right click the figure which need to modify in the layer list, a dialog box will pop up:

![Modify Figure Name Dialog Box]

Click “ok” after modifying.

C. Drag graphics from graphic library to workspace

User can drag graphics from graphics library to workspace by press the left button and keep press status to move the mouse to the workspace, then user can roll the mouse wheel to rotate the graphic during the moving. After the left button loosen, the graphic can be draw in the workspace and then software can mirror the graphic automatically, user can continue to insert the graphic to workspace by press the left button, and also can press the right button to cancel.

2.2.1.6.1 Advanced features of the graph library

Click the menu “Views” → “Graph library” to show the graph library panel, right-click on the blank area:
Overall import file: All graphics elements of the file imported will be combined into one graphic unit, and then import it to the list. Or else, all graphics will be broken into a separate graphics.

Mirroring import file: All graphics are imported, and then a mirror of them is generated at the same time.

Delete all: Delete all graphics in the library list.

Add by pair: According to the characteristics of the shoe industry, mark a “pair” property to those graphics imported. When the graphic is dragged out, a pair of the graphic will be forced to generate.

Set number: Set the maximum number of graphics in the list. When the number becomes 0, the graphic cannot be dragged out.

1) Overall import file

For example, the original figure of the dxf file is shown as below:

![Fig. 2-82 the original figure]
The left picture shown above is using the option of “Overall import file”, and the right is not.

2) Mirroring import file

For example, the original figure of the dxf file is shown as below:
Fig. 2-85

The left picture shown above is using the option of “Mirroring import file”, and the right is not.

3) **Set number**

For example, there is an order form. All graphics in the list are set maximum number to be 20.

Right click the option “Set Number” of the menu.
4) **Arrange graphics with the library**

In the above case, set max number to be 20. Arrange the first two graphics of the library list to be two arrays. Two arrays are arranged in 2 rows and 5 columns. And then its corresponding graph reduction 10.

When the number of graphic becomes zero, the graphic cannot be dragged out again.
2.2.2 Drawing and Graph Attribute

In the following, we are going to introduce how to draw graph and how to set the attribute.

2.2.2.1 Graph Selection

Select a single graph:

It is done by pressing the left key of the mouse on a single graphics. First, click the button on drawing toolbar, and then click the figure that you want to select by pressing the left key of the mouse. The state of figure being selected is shown as follows:

Property of enclosing rectangle can be set in attribute setting area of the graphics. If the size parameter have changed and taken effect, the enclosing and the selected graphics will follow to change.

- Tick the lock option, the selected graphics would be locked; you cannot modify its property parameter and move it.
- Click the icon, if it is in the hollow state, the size of locked graphics is locked; if you modify one parameter of it, another parameter will also change according to proportion.
- Tick process option, the graphics will export when processing, otherwise not process.

After modify relevant option, click “apply” button, the modify will take effect.

Select multi-Notele figures:

Method 1: By mouse

Click the button in drawing toolbar, and press the left key of mouse in a place of drawing area to fix the starting point of the rectangle, and then hold and drag the mouse to adjust the size.
of rectangle until a desired rectangle is drawn. All figures inside this rectangle are selected. Detailed operations are shown as follows:

A dashed-line selection rectangle formed by dragging the mouse:

![Fig. 2-92](image)

As the following picture shows, figures inside the selection rectangle are selected:

![Fig. 2-93](image)

Method 2: By operating graphics list
You can also select one or many figures in the graphics list.
Select a graphics from the tree control in list by clicking the left key of mouse, and the relevant graphics in the drawing area will also be selected.

![Fig. 2-94](image)

If you select “Layer 1” in the tree control, all graphics under this layer will then be selected; or you can press the Ctrl key and click the graphics in the list to select.

![Fig. 2-95](image)
2.2.2.2 Object List Operation

Object list is a dendriform list frame, use to show and manage the current drawing figure as follow:

![Object List Diagram]

The object list separate into three tiers: the first tier is “document”, the second is layer, the third is graphics. The array gradation is the deferent process gradation. We can select and move the graphics through the mouse. Right click the graphics, it will pop up a dialog box to modify graphics name, users can named the graphics by yourself.

Click the icon of toolbar, show or conceal the tree list of object list.

2.2.2.3 Graph Node Editing

Draw a line, polygon or Bézier curve, and then select and double click it to enter the node state (or click button in the drawing toolbar and then click the graphics) when the graphics will have several key points displayed as small hollow rectangles, you can drag these key points with mouse to edit the graphics.

In node editing state, move the cursor on any edge of graphics and double click it to add a new node. You can double click it on this node again to delete the node.

A. MulNotele-choice function: you can use the Ctrl and Shift keys on keyboard to select the figures conveniently.

Press ea the Ctrl key and click the graphics in the drawing area, all selected graphics will be in checked status. If you click the selected figure again, the checked status will disappear.

B. Press the Shift key and click the graphics in the drawing area, all selected graphics will be in checked status. If you click the selected figure again, it will be changed to modification state and node editing state.

C. Shortcut of Select All: Ctrl + A

D. Press Ctrl+ up/ down key to switch the reference graphics.

Note

A. MulNotele-choice function: you can use the Ctrl and Shift keys on keyboard to select the figures conveniently.

Press ea the Ctrl key and click the graphics in the drawing area, all selected graphics will be in checked status. If you click the selected figure again, the checked status will disappear.

B. Press the Shift key and click the graphics in the drawing area, all selected graphics will be in checked status. If you click the selected figure again, it will be changed to modification state and node editing state.

C. Shortcut of Select All: Ctrl + A

D. Press Ctrl+ up/ down key to switch the reference graphics.
For line, it is able to operate more nodes. More details please refer to 2.2.2.4.

For rectangle, it is able to operate inverse round by editing the nodes. More details please refer to 2.2.2.5.

For regular polygon, it is able to zoom in, zoom out or rotate it by editing the nodes. More details please refer to 2.2.2.6.

For ellipse, it is able to form a section of circular arc by editing the nodes. More details please refer to 2.2.2.7.

For Bezier, it can be edit more by editing the nodes. More details please refer to 2.2.2.8 and 2.2.2.9.

2.2.2.4 Line

**How to draw:** Click button in the drawing toolbar to enter the straight line drawing state, and click in the working area successively to set the nodes of straight line, and then click the right key to pop up menu as:

![End Line, Close, Set Coordinate]

Fig.2-89

If you select “End”, the straight line drawing will be ended.

If you select “Input coordinate”, a dialogue box will show up:

![Input Coordinate]

User can set the precise coordinate value of X and Y axes to confirm the position of node.
Press “control” can draw a string which given angle, every 15° one angle. It is convenient for user to draw a horizontal line or the line which given angle.

1. **Move node**
   - **Move single node**
     Double click the straight line to turn it into modify state, click discretionary node of straight line, then move the mouse. At this moment, a new straight line will move follow the mouse as follow figure:

     ![Fig.2-91](image)

     **Fig.2-91**

   - **Move multi-node**
     Double click the straight line to turn it into modify state, Move the nodes by pressing and holding the left key of mouse, draw a rectangle dashed frame, then loosen the left key. At this moment, multi-node would be chosen, and then move discretionary node of multi-node, other chosen node will move by the same distance as follow:

     ![Fig.2-92](image)

     **Fig.2-92**

2. **Delete node**
   - **Delete single node**
     Move the mouse to one node, then double click the left key of mouse, the current node will be deleted.
   - **Delete multi-node**
     Select multi-node, double click one node of the multi-node or press “delete” key of keyboard, the all chosen nodes will be deleted.

3. **Add node**
   Move the mouse to any string of the straight line, double click the left key of mouse, a new node will be add at the double click position as follow:
4. Modify the direction of curve

It can only modify the direction after switch curve, when the figure is not closed, it can only set the start point or end point for the start point. When it is close curve, it can set any point of close curve for the start point, it can also set the working direction.

When it is not close curve, it only has the “reverse” function. Right click the mouse; the right key menu will pop up as follow:

Click “reverse”, the direction of curve will change as follow:

When it is close curve, it can use “reverse” and “set the start point”.
The “reverse” function is the same as the unclose curve.

Set the start point: Move the mouse to any node of current close curve, right click the mouse, select “set the start point”, set the current node for working start point.

![Fig.2-97](image)

### 2.2.2.5 Rectangle

**How to draw:** Click button in the drawing toolbar to enter the rectangle drawing state, press and hold the left key of mouse to set one of the endpoints of rectangle in drawing area, and then drag the mouse to adjust the rectangle size until the end of drawing.

Enter the node editing state, select and drag any one of the four nodes to get the rectangular fillet.

![Enter the node editing state](image)

**Property settings:** Likewise, select a rectangle, and the rectangle property will be displayed in the graphics property area, where user can set different values to adjust the selected rectangle.
As shown in the above picture, in addition to the property of enclosing rectangle (the same as line mentioned above), there is also the own attribute:

**Width (mm):** Set the width of rectangle.

**Height (mm):** Set the height of rectangle.

**Round radius (mm):** Set the fillet radius of four circular arcs of rectangle.

You draw a square instead of rectangle if you press and hold the Ctrl key when drawing.
2.2.2.6 Regular Polygon

**How to draw:** Click the button in the drawing toolbar to enter the regular polygon drawing state, and then press and hold the left key of mouse in drawing area to adjust the size of figure until a desired figure is drawn.

Select the regular polygon to enter the node editing state, and then click the left key on key nodes to drag to change the size or to rotate the figure.

![Fig.2-101](image)

**Property settings:** Select the regular polygon and the property will be displayed in graphics property area, where user can set different values to adjust the selected regular polygon.

![Fig.2-102](image)

- **Edges count:** Set the edge numbers of regular polygon. The default is 5, and the maximum is 500.
- **Radius (mm):** Set the distance from the center to each vertex, that is, the radius of circumscribed circle.

2.2.2.7 Ellipse

**How to draw:** Click the button in the drawing toolbar to enter the ellipse drawing state, and then press and hold the left key of mouse in drawing area to adjust the size of figure until a desired figure is drawn.

Select the ellipse to enter the node editing state, and then click the left key on key nodes to drag to adjust the start angle and end angle of ellipse.

![Fig.2-103](image)

**Attribute settings:** Select the ellipse and the attribute will be displayed in attribute area, where user can set different values to adjust the selected ellipse.
Start Angle (degree): As shown in the following picture, unit in degree

End Angle (degree): As shown in the following picture, unit in degree

Rotate Angle: An angle at which the graphics circles around the center, unit in degree

Long Radius (mm): the major axis of ellipse, as shown in the following picture, unit in mm

Short Radius (mm): the minor axis of ellipse, as shown in the following picture, unit in mm

Center (mm): X and Y coordinates of center position of ellipse

If the major axis is equal to minor axis, it is a circle.

Current direction: Click this button to set the direction as clockwise or anti-clockwise
2.2.2.8 Bézier Curve

**How to draw:** Click button in the drawing toolbar to enter the Bézier curve drawing state, and press the left key of mouse in different places of the drawing area, and then press the right key to pop up menu as:

![Fig.2-107](image)

**End line:** End the drawing of Bézier curve.

![Fig.2-108](image)

**Close:** The last node and the first node of Bézier curve are Linked to form a closed curve.

**Set coordinate:** Pop up dialogue box, just the same as straight line settings, user can set the precise X and Y coordinates.

Drawing the Bezier is based on the point of curve to account Bezier curve automatically. The node edit function can modify the point position, it can support to edit mutil-node.

The steps as follow:

![Fig.2-109](image)
2.2.2.9 Bézier Curve2

**How to draw:** Click \( \text{button} \) in the drawing toolbar to enter the Bézier curve2 drawing state.

**Drawing manner:** left click mouse, one point will show in the drawing area. If you want to modify the coordinates of control point, you can click and hold the left key of mouse and move it. You will see two control points change follow the mouse, move it to the appointed position and then loosen it.

If you want to end the current drawing, right click the mouse, choose any one to end in the right key menu.

**End line:** End the drawing of Bézier curve.

**Close:** The last node and the first node of Bézier curve are Linked to form a closed curve.

Bézier curve is through control point to create curve, it is support to edit multinode.
Move node

The move manner of node is as the same as straight line.

Delete node

The delete manner of node is as the same as straight line.

Add node

The manner is as the same as straight line, but add node will not hold the primary curve. If you add node on one curve, the primary curve may distortion.

Curve edit

You can modify the Bezier curve at current node editing manners through these two manners: one is modify the coordinates of control point, another is edit curve directly.

Control point manner

1) Switch to node editing mode, click any node of curve. (not include start point and end point). At this moment, four control points will appear: back control point of front node, front control point and back control point of current node, and front...
control point of back node. Through these four control points can modify the curve of current chosen node. (Start point only has back control point, end point only has front control point.)

Fig.2-117

2) If the current chosen nodes are not start point and end point, the icon of Bezier toolbar in effect. Toolbar will choose a edit mode base on the connection of current chosen node. As above figure, current node and its control points are in the same line, and its control points are symmetry, so the symmetry button is in chosen status as follow:

Fig.2-118

3) User can modify the mode of current node which you need, now, we will explain the node editing in different modes:

- Transition sharply

When user edit one control point, another would not change. One side of the curve will change, another side will not. It will lead the transition of current node turn large.

Fig.2-119

- Transition smoothly

When user edit one control point, another will keep in the same line with current node and change unsymmetrical. The curve of current node become more smoothness.
Transition symmetrically

Control points and current node assume a line, and change symmetrically. So move one control point, another will follow to change under the node editing. Both curve of node will change by the same proportion at the same time.

4) Edit curve directly

User can modify curve through mouse to click one curve and drag it.

It also has three modes of control point editing when edit curve. The above figure is transition symmetrically, because when drag one curve, three curve follow to change, and change symmetrically.

We will explain how the three modes switch each other.
If users want to edit that curve which arrowhead point. Base on the characteristic of Bezier curve2, the current curve control by two control point, one is back control point of front node, another is front control of next node. So the edit mode of these two should be modified.

If the edit mode of front node is “transition sharply”, when edit this curve, the front curve will not follow to change.

Other modes are the same as it.

This software support two Bezier curves:

Bezier1 is just need to confirm the point when drawing, then account the Bezier curve automatically.

Bezier2 is that through adjust the two control point of node to modify Bezier curve when drawing.

2.2.2.10  Text

How to draw: Click button in the drawing toolbar to enter the text drawing state, and press the left key of mouse in drawing area, a default text “TEXT” will then be displayed in the current position.

Text Property: Select the text and the property will be displayed in property area, where user can set different values to adjust the selected text.
**Font**: set the font of text (support TrueType Font and Shx Font), font style, effect, etc.

**Size**: adjust the size of text.

**Text**: input or modify text, support to input multi-row text.

![Fig.2-125](image)

![Fig.2-126](image)

**Button**: “B” shows thick text; “I” shows italics; “F” to enter font setting dialog box, set its show and typeset mode as the following figure:

![Fig.2-127](image)

- The above three button are: left, centered, right.
- **Distance (%)**: Set the space between words, unit in %.
- Distance between words= Height of a single word *distance (%)

Company Headquarter: No.28 East Industrial Road, Songshan Lake High-Tech Industrial Development Zone, Dongguan, Guangdong, China.
Array manner (mm): Line and arc array are supported. The default is line array. To array the words in arc circular form, click “Arc” option and set the radius of arc array in “Circular arc radius (%),” and then click “Apply” to confirm. Radius of arc array = Height of a single word*circular arc radius (%).

Such as arraying “0123456789” as circular arc:

**Text:** Content of text

**Font:** Set the font, font style, effect, etc. of the text.

### 2.2.2.11 Drill

**How to draw:** Click button or use the shortcut F11 to enter the perforation drawing state, and click in the working area to draw:

**Property settings:** Select the Perforated graphics and the property will be displayed in property area, where user can set the time delay (ms) to adjust the perforating time.
2.2.3 Edit

The following several operations are provided, namely Copy, Delete, Cut, Paste, and Replicate.

2.2.3.1 Copy (Shortcut: CTRL+C)

Select the graphics that needs to be copied and then click the button in figure editing toolbar or press shortcut CTRL+C, or right click the mouse to pop up menu as:

<table>
<thead>
<tr>
<th>Delete (X)</th>
<th>Del</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy (C)</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Cut (X)</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Clone (F)</td>
<td>CTRL+V</td>
</tr>
<tr>
<td>Mirror (B)</td>
<td>CTRL+M</td>
</tr>
<tr>
<td>Add to graph lib (F)</td>
<td>CTRL+I</td>
</tr>
<tr>
<td>Fill (F)</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Convert to Light Guide (F)</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Convert Line (L)</td>
<td>Ctrl+2</td>
</tr>
<tr>
<td>Convert Array (A)</td>
<td>Ctrl+3</td>
</tr>
<tr>
<td>Link Line (L)</td>
<td>Ctrl+4</td>
</tr>
<tr>
<td>Convert Bead (B)</td>
<td>Ctrl+5</td>
</tr>
<tr>
<td>Find Overlap Line (F)</td>
<td>Ctrl+6</td>
</tr>
<tr>
<td>Snap Graph (F)</td>
<td>Ctrl+7</td>
</tr>
</tbody>
</table>

After pasting, the system will generate a new graphics with the same attribute as original at the same position.

2.2.3.2 Delete (Shortcut: Delete)

Select the graphics that needs to be deleted, and then press the shortcut “Delete” key to delete or right click the mouse to pop up menu as:
Click “Delete (D)” to delete.

You can select figures in drawing area or from tree control in graphics list, and press “Delete” key to delete the figures.

### 2.2.3.3 Cut (Shortcut: CTRL+X)

Select the graphics that needs to be cut, and then press button or the shortcut “CTRL+X” to cut, or right click the mouse to pop up menu as:

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy (C)</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Cut (C)</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Clone (Z)</td>
<td>CTRL+H</td>
</tr>
<tr>
<td>Mirror (M)</td>
<td>CTRL+E</td>
</tr>
<tr>
<td>Add to graph lib (L)</td>
<td>CTRL+I</td>
</tr>
<tr>
<td>Fill (F)</td>
<td>CTRL+U</td>
</tr>
<tr>
<td>Convert to Light Guided (L)</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>Convert Line (L)</td>
<td>CTRL+F</td>
</tr>
<tr>
<td>Convert Array (A)</td>
<td>CTRL+D</td>
</tr>
<tr>
<td>Link Line (L)</td>
<td>CTRL+L</td>
</tr>
<tr>
<td>Convert Dashed (D)</td>
<td>CTRL+D</td>
</tr>
<tr>
<td>Find Overlap Line (L)</td>
<td>CTRL+O</td>
</tr>
</tbody>
</table>

### 2.2.3.4 Paste (Shortcut: CTRL+V)

After the copy or cut of graphics, you can click button in figure editing toolbar or shortcut CTRL+V to paste the graphics. After pasting, the system will generate a new graphics with the same attribute as original at the same position.

### 2.2.3.5 Cut Out (Shortcut: CTRL+U)

The clip function is only applicable to curve for the moment. The curve can be line or dashed. For other graphics (such as rectangle, polygon, and ellipse), users can right click them and choose “Convert to line” for conversion.
Upon choosing the curve, you may perform the following four operations to enter clipping state: click in the toolbar, use the shortcut CTRL+U, click “Cut out” in the right-click menu, or click “Edit”->“Cut out” in the main menu.

Fig.2-135

How to clip

Fix two points on the selected primitive to clip. (These points can be the nodes or midpoints of the selected primitive or any one point on a certain line segment).

How to show the clipping feature interface

Follow the steps below to fix the coordinates of the two points.

After accessing the clipping mode, move the mouse until the cursor touches the primitive but not a node, and the cursor changes to the shape of scissors while a point shows up on the selected primitive. Click to fix the point. When the cursor touches the node of the selected primitive or the midpoint of a certain line segment, it changes to the shape of . Then, click to fix the point.

Fig.2-136 Before edit
2.2.3.6 Clone

Select the graphics that needs to be replicated and right click the mouse in drawing area to show a menu as:

Select “Replicate (E)” and a dialogue box shows up:
**Rows**: Set how many figures can be replicated in each line.

**Columns**: Set how many figures can be replicated in each column.

**Rows interval**: Set the space between figures in each line, unit in mm.

**Columns interval**: Set the space between figures in each column, unit in mm.

Take drawing a circle as an example, set it as 3 lines and 3 columns, the line spacing and column spacing are both 2mm:

![Diagram showing column and line spacing](image)

**2.2.3.7 Undo (Shortcut: Ctrl + Z)**

After drafting a figure or modified parameters of figure, you can press shortcut Ctrl+Z or click to cancel the current operation and return to the previous operation.

**2.2.3.8 Re-do (Shortcut: Ctrl + Y)**

After the canceling, you can press shortcut Ctrl + Y or click button to re-do and return to the next operation.
2.2.3.9 Alignment

In toolbar:

There are several manners of graphics alignment: Put to origin, Align left, Align right, Align top, Align bottom, Align center, Make same width, Make same height, Make same size, Space across, and Space down.

When users choose multi-figures, there is a figure will be circled by a black dashed box in the drawing area. This figure is the reference figure, the align operation is based on this figure.

User can press and hold the “shift” key and click the any one of chosen figure to change the reference figure.

Put on origin: Put on the selected or all graphics to the origin as follow:
Fig. 2-146 Selected graphics put on origin

- Left: Allow the selected graphics to align at left side of enclosing rectangle

Fig. 2-147

- Right: Allow the selected graphics to align at right side of enclosing rectangle

Fig. 2-148

- Top: Allow the selected graphics to align on top of enclosing rectangle
Fig. 2-149

Bottom: Allow the selected graphics to align at bottom side of enclosing rectangle

Fig. 2-150

Center: Allow the selected graphics to get close to the center of enclosing rectangle

Fig. 2-151

Make same width: Set the same width between selected graphics and reference graphics.
Fig. 2-152

Make same height: Set the same height between selected graphics and reference graphics.

Fig. 2-153

Make same size: Set the size of selected graphics same as the reference graphics.

Fig. 2-154

In addition, additional different manners of alignment are provided. In toolbar:
Distribute rows evenly: The selected graphics is horizontally aligned with equal space in the enclosing rectangle.

Distribute lines evenly: The selected graphics is vertically aligned with equal space in the enclosing rectangle.

For example, distribute rows evenly:

![Fig.2-155 Before](image1)

![Fig.2-156 After distribute rows evenly](image2)

### 2.2.3.10 Prev. Graph

This function mainly use to looking for prev. graph from selected graphics. If there is not any graphics be selected, you will look for the first figure in current list when you click this menu. Its keyboard shortcuts is “CTRL+UP”. This function also reflects the working gradation of current graphics.

### 2.2.3.11 Next Graph

This function mainly use to looking for next graph from selected graphics. If there is not any graphics be selected, you will look for the first figure in current list when you click this menu. Its keyboard shortcuts is “CTRL+DOWN”. This function also reflects the working gradation of current graphics.

### 2.2.3.12 Snap Graph

Select “View”→“Snap graph” in the main bar, or press “CTRL+P”, or select “snap graph” by right click mouse to turn on snap graph function, only support to snap the end point and midpoint of line of graph when drawing.
2.2.4 Modify

Functions available for the moment include: Mirror, Fill, Coordinate system, Move, Rotate, Shear, Stretch, and Shift Array, Cutting starting point, and processing direction.

2.2.4.1 Mirror

Select the graphics, and click “modify” → “mirror” and right click the mouse to select “Mirror (M)”. A dialogue box pops up:

“X mirror”: after tick it, the object take y-axis for the center, mirror at the X direction.

“Y mirror”: after tick it, the object take x-axis for the center, mirror at the Y direction.

Tick off X mirror and Y mirror at the same time, the origin will be the benchmark for mirror.

More function of mirror, please refer to 2.2.5.3.
2.2.4.2 Fill

Fill in the closed graphics as follows:

A. Draw a graphics that can be filled (closed curve such as rectangle, ellipse, text, vector diagram, etc.).

B. Select the graphics and right click the mouse to choose “Fill” from the pop-up menu, and then a dialogue box shows up:

![Fill dialogue box](Fig.2-163)

**Direction:** For X unidirectional filling, it is filled from the left side of filling line to the right side (or from the right side to the left side) every time. For X bidirectional filling, it is filled from the left to right (or from right to left) first, and after that it jumps to the right (or left) side of the next filling line and starts the laser to scan. This operation is repeated until the end of the filling.

Likewise, for Y unidirectional filling, it is filled from the top of filling line to the bottom (or from the bottom to the top) every time. For Y bidirectional filling, it is filled from the top to bottom (or from bottom to top) first, and after that it jumps to the bottom (or top) of the next filling line and starts the laser to scan. This operation is repeated until the end of the filling.

**Scan precision (dpi):** Set the space between filled lines to control the spacing of filling, unit in DPI and is expressed as line/inch. The smaller the value is set, the bigger the space between lines when scanning would be. The larger the value is set, the closer the space between lines would be.

**Ascent (mm):** If a value is set here, the edge of carved figure would then have gradient. Generally, the gradient is started from the periphery of line. The smaller the value is, the steeper the gradient would be. There is no gradient when the value is 0.

**Delete contours:** whether to delete the original graphics.

1. The minimum light intensity cannot be equal to the maximum light intensity. If the minimum light intensity=maximum light intensity, there would be no gradient.

2. The filled layers are usually for engraving, and the speed is different from cutting speed; therefore, it is recommended to set the filled graphics and cutting graphics in different layers.
2.2.4.3 Coordinate

This software is capable of switching the coordinate system. Right click the mouse in drawing area, and select “Coordinate system” from the pop-up menu or select “Modify (M)” -> “Coordinate system (C)” from the menu bar:

Fig. 2-166

The coordinate point can be set as left up, right up, or left down, right down, which is taken as the origin of coordinates. Please select the right option according to the machine. (Attention: at No.3 controller and No.4 controller, when modify this parameter, the opposite setting of machine parameter would also be modified:

Fig. 2-167

The result is shown as follows:

Fig. 2-168 left down right up
The meaning of each option:

**Left down:** Origin of coordinates is at bottom left, and is engraving and exporting toward the upper right when operating.

**Right up:** Origin of coordinates is at upper right, and is engraving and exporting toward the bottom left when operating.

**Right down:** Origin of coordinates is at bottom right, and is engraving and exporting toward the upper left when operating.

**Left up:** Origin of coordinates is at upper left, and engraving and exporting toward the bottom left when operating.

For example: Origin of a machine is at upper right, click “right Up” in the dialogue box of coordinate system, and the interface will display the coordinate system as shown in Figure 2-170.

The following is the figured diagram of machine (top view); the origin of machine is corresponding to the origin of coordinates at the upper right.

**2.2.4.4 Close Curve**

Close open curves.

- Select one or more open curves, and click “Modify (M)”-> “Close” in the main menu, the “Close” item in the right-click menu, or the icon in the toolbar to close the curve.
2.2.4.5 Link Line

Link line is used to link curve which has similar node to a new curve, its precision lie on “link precision “of “setting” (refer to software scheme)

For example, draw two straight line, one point of one straight line and another point of another line are superposition. Then select these two line, right click “link line” or click “link line “ of “modify” or click in the toolbar to link line. They will become one line.

2.2.4.6 Convert Line

Convert the selected figure into line: The cutting starting point and processing direction can be changed only when the figure has been converted to line.
2.2.4.7 Convert Dashed

Convert the selected figure into line: supported line, rectangle, regular polygon, ellipse, Bezier and text.

Click “modify” \(\rightarrow\) “convert dashed” or click “convert dashed” in the right click menu, a dialog box will pop up:

**Blank length:** the blank between line and line as \(L_2\) of above figure.

**Smooth:** if the curve has serration, tick this option, the system will smooth it as follow:
Dashed: tick this option, convert the current curve into dashed.

Segment length: the segment length of dashed as L1 of above figure.

Drill: drill the above segment of dashed into drilled figure.

Drill time: the lighting time.

Such as an ellipse (width is 13mm, height is 5mm) convert into the dashed figure which the blank length is 1mm and the segment length is 1mm as follow:

Covert line function, after covert line into dashed, “convert line” button will appear at the property panel:
2.2.4.8 Curve Starting Point and Direction

The curve starting point and direction of graphics can be set via software. For example, draw a graphics and select in menu bar “Modify (M) → “Convert to line”. After that, select and double click the graphics, a red arrow will show up, indicating the curve starting point and the cutting direction:

You can right click the mouse at the red arrow to set the reversal processing, or on the other nodes to set the starting point of curve, while 

will show up. After the settings, the figure is as follows:
If the selected figure is closed figure, the set start function is also supported. Right click the mouse, while the following menu will show up:

![Set Start Menu](image)

Select “set start” item, the red arrow will show at the current position of new start point as follow:

![Red Arrow](image)

### 2.2.4.9 Shrink and Expand

Shrink and expand is mainly shrink and expand the original graph for opposite size, the size is the following interval. Different lasers may give out spots in different size after focusing. This function only support close curve graph. Rectangle, regular polygon, ellipse may use this function after convert curve.

To compensate:

- Choose one closed curve, click “Modify (M)” → “Shrink and Expand” in the main menu or “Shrink and Expand” in the right-click menu to pop up the Shrink and Expand window as the following picture shows:

![Shrink and Expand Window](image)
**Layer count:** the total count of shrink and expand.

**Interval (um):** the distance between two graphs when shrink and expand, the unit is mm.

**Grads:** the unit is mm; when shrinking, according to this grad to shrink by descend distance; when expanding, according to this grad to expand by increase distance.

**Shrink/Expand:** Select to stretch the curve shrink or expand.

**Delete original graph:** Tick to delete the original figure.

**Example:** draw a round that radius is 6mm, then convert curve, select shrink and expand function; (attention: the gray round is primary graph.)

Pay attention, half of the short side of the external rectangle $\geq$ layer count x interval; otherwise shown as follow:

The half of the short side value of the external rectangle is the radius of the circle as above figure.
Fig. 2-189  Non-proportional shrink

Pay attention to another relationship: interval \( \geq \) layer count \( \times \) grads; otherwise follows:

Fig. 2-190  Interval < layer count \( \times \) grads; only shrink 2 layer

Take a 15mm x 10mm rectangle for example to show expand:

Fig. 2-191  Geometric proportion expand
Shrink and expand at the same time:

The diameter compensation generates dimmed figures as the original, which will not be processed when being outputted.

The default state in the output does not participate in the processing; you can through the object list property panel to tick “process” option to set the processing status.

2.2.4.10 Leadin / Lead out Line

Leads are mainly applied to high power laser or high precision processing industries.

If no leads were added, match points would appear at the start position when processing closed figures, thus producing nonconforming products. This is because the engine is still speeding up when laser beams are given out at the start position.

After adding leads, a distance will be left for the engine to speed up before processing starts. In this way, the match point problem can be solved. The distance is referred as a lead.

There are two kinds of leads: leadin and lead out.

The feature is only available for closed curves for the moment.
To set parameters of the lead:

- After choosing the closed curve, click “Modify (M)"->"Add lead” in the main menu or “Add lead” in the right-click menu to pop up the lead adding window as shown below:

![Add lead window](image)

**Overlap length (mm):** When processing closed figures, processing are enabled and ended at the start position, which will result in a different effect at the starts. Solution: Set a point instead of the start for processing. This is the work of over-cutting length.

**Lead In/Out:**

- **Lead In length (mm):** Provide a length for the engine to speed up.
- **Lead Out length (mm):** Provide a length for the engine to speed down.

**Auto compute angle:**

Tick to enable the software to compute the angle of lead in/out angle automatically. Users can also set the lead in/out option.

![Add lead window](image)

Deselect indicates that users can configure the lead in/out angle separately as below:
2.2.4.11 Set Curve Precision

Different processing technology requires different processing data. Precision demanding industries require high precision data after processing, while other industries not. The curve precision feature in the system is compatible with the two processes above.

To set the precision:

- Cancel the selected graphics, and click “Modify (M)” -> “Set curve precision” in the main menu or the “Set curve precision” item in the right-click menu to pop up the corresponding setup dialog box shown as below:
**Curve Precision:** Refers to the minimum point-to-point spacing. The smaller the value is, the higher the precision is. The spacing ranges from 0.020 to 10 in mm.

The figures below are screenshots of curve converted ellipse in same size but different precision. Different effect after conversion of curve can be found.

**Fig.2-200  Curve precision: 10mm**

**Fig.2-201  Curve precision: 0.020mm**

In addition, you can set curve precision at “config” interface, please refer to 2.2.9.

### 2.2.4.12 Optimize Path

Cancel the selected graphics, and click “Modify (M)” -> “Optimize Path” in the main menu or the “Optimize Path” item in the right-click menu to pop up the corresponding setup dialog box shown as below:
Fig. 2-202

Sort by layer: array from low to high according to the priority of the layer properties when tick it, and then array the graph of the layers according to the selected array method of the above graph;

From in to out: When there are graphics within the graphics, processing the inner graphics first, reprocessing the external graphics.

Nearest start: The system automatically optimizes the graph starting point; select the nearest start as a starting point for processing from the current processing point.

Smooth start: The system automatically optimizes graph starting point, make the curve direction as close as possible to the direction of the current processing route, reduce the large-angle turning to reduce the machine performance when processing.

Original start: The system does not optimize primitive starting point, processing by the graph starting point of drawing.

Work start: According to the selected position, work start from the graph starting point of this area.

OK: put in the current settings, and take effect immediately.

Set: To save the current settings, do not take effect immediately, but after ticked the "System Settings" ---> "Output path optimization", the effective output only;

Cancel: does not save the current settings modified.

Path optimization is divided into two ways:

❖ Shortest path

To achieve shortest path: First, lookup the nearest graph for the first processing graph from the current starting position by the starting position at the starting point of machining. And then lookup the nearest graph for the next processing graph from the end position of the former graph from other graph. And so on as the next processing map.
Before setting optimization (left is drawing area, right is simulation route)

Upper figure was before setting optimization, processing path output according to drawing order, which right arrow shown route is processing travel route, green is processing route and white is jump directions. (Please refer to section 2.2.8.6 about path simulation details)

Different starting point set as follows; take the shortest path for examples to illustrate:

 выбрать. 

- Path optimize setting is shown as figure 2-204, select the original start; simulation processing route is shown in figure 2-205;

- Situation 2: path optimize settings as shown in figure 2-206, select Smooth start, the simulation processing route is shown in figure 2-207;
Situation 3: path optimize settings as shown in figure 2-208 select the nearest start, the simulation processing route is shown in figure 2-209;
Sort by layer:

The process order of the above figure is processing by the default layer priority from layer 1 to layer 2, and then to layer 3.

Attention

For the multi-layer graph processing, before using path optimization and do not tick the "subarea optimize", you should ensure that the layer processing state of the priority layer 1 in the list is “yes”, otherwise it will not output processing. This is due to the system of processing data; all processing graphics are placed in the first layer to output processing.

from in to out:
Fig.2-212 Primary drawing area

Fig.2-213 Parameter setting

Fig.2-214 Left is before optimizing, right is after optimizing

You can know that combined with different parameter choice to analyze the processing route, so as to achieve the best optimization from the above analysis.

✧ Subarea optimize

Fig.2-215

Subarea optimization means to the entire effective processing area is divided into a number of sections, using the shortest path within the section. After processing all the graphics of one section, and then process others graphics of latter sections till all sections done with processing.
Fig. 2-216 left is the processing track route of shortest path, the right shows the processing track route of subarea optimization

Refer to the following screenshots for details about subarea optimization:

✧ Suppose the working area is 600*400mm, now there is a 80*80mm square cloning into 5 rows * 7 columns, as the following picture shows:

Fig. 2-217

✧ During path optimization, the width and height of the subarea is set to 100*100mm and the bottom left corner is set as the start point for processing. Now, it seems that a 100*100mm rectangle is continuously moving from left to right, as the following picture shows:
The rectangle enclosed in the red one is the first graphic to be output. Upon continuously moving, the red rectangle is enlarged to 200*100mm, as the following picture shows:

Now another graphic enters the red area and will be the second primitive to be output, and so on. After finish scanning the first row, it directly accesses the next line.

The sequence for processing graphics depends on the order to enter the red area. The arrows above indicate the moving direction of subarea, which complete until the entire working area is scanned.
When optimizing, large data may lead the optimize time over long. If user wants to end the optimization, click the “cancel” button as following figure:

![Optimizing path, please wait...](image)

Fig.2-221

### 2.2.4.13 Convert Drill to Small Circle

The system supports the conversion of perforated graphics to small circle.

Select one or more perforated graphics, and click “Modify (M)” -> “Drill to small circ” in the main menu or the “Drill to small circ” item in the right-click menu to pop up the corresponding setup dialog box shown as below:

![Convert drill to small circle](image)

Circle radius (mm): 500

Click “ok” after setting the small circle radius, the selected perforated graphics will drill to small circle. All perforated graphics of current figure will drill to small circle under the perforated graphics have not been selected.

### 2.2.4.14 Convert Small Graph to Drill

If users need to process these graphics, they can convert them to perforated to output for processing.

Select one or more small graphics, and click “Modify (M)” -> “Small graph to drill” in the main menu or the “Small graph to drill” item in the right-click menu to pop up the dialog box for you to set the time delay for perforation, as the following picture shows:

![Convert small graph to drill](image)
Click “OK” after setting drill delay, the selected graphics will drill. The system will make all the small graphics accord with request to drill if the graphics have not been selected. Whether a graphic accord with small graphics or not, it rest with “small graph to drill precision” of “config” interface. Only the graph less than the precision, it can convert small graph to drill. Otherwise, this function is noneffective.

2.2.4.15 Group/Scatter

With “Group” function, several selected graphics can be combined into a group. The operation for the group is equal to all the graphics. Such as move, rotate, mirror, etc. You can choose “Group (G)” option to form these figures into a new integrated figure.

With “Scatter Group” function, you can break the selected combined diagram into several figures.

- Select several figures, click “modify”→”group” in the main menu or click the in the toolbar or right click the mouse to group.

![Group/Scatter Menu](image)
How to scatter group:

- You can choose “Scatter” option or click button or right click “scatter group” to break the selected combined diagram into several figures.
Fig. 2-227

Before scatter group
2.2.4.16 Convert Array and Leftover

The array conversion functions as cloning. The only difference lies in that the columns and rows are calculated automatically by the system for conversion. For double laser heads, they are displayed in the same way on the screen but different in processing. The system automatically works out the spacing between the two heads, and a column of data will be completed by two laser head, greatly enhancing processing efficiency.

The “Scatter” item works to separate the entire graphics in the array, similar to the function of “Break”.

To convert to array:
- Select one or more graphics, and click “Modify (M)” → “Convert Array” in the main menu
- or click in the toolbar or the “Convert Array” item in the right-click menu to convert to arrayed graphics, as the following picture shows:
The display of interface after conversion:

- The working area will be filled with arrays converted from graphics, as the following picture shows:

- The display of graphics list: The graphics of one array are displayed in the tree structure, and the corresponding attributes are displayed in the Attribute bar, as the following picture shows:
The mutual property of array property cannot be modified. As seen from the picture above, the common properties in the array’s properties are dimmed, indicating that arrayed don’t support editing features like moving, rotating, shearing, and stretching.

Array properties:

**Rows/Columns:** The default value, which is worked out by the system based on the current working area, can be modified as required.

Choose the option on the right side of the rows, the picture is shown as below:

Then you can see the parameter had changed to Number, now the array number is 12, so user can set the number of the array to generate the main array data and sub array data. If user set the number is 23.
Fig.2-234  The rows of the main array is changed to 5

Fig.2-235  Generate a new sub array of 1 rows and 3 columns.

**Rows/Columns interval:** Defaulted as 0 and can be modified. Suppose both parameters are set to 15mm, the arrayed primitive will show as below:
**Rows mismatch:** Defaulted as 0, indicating the misalignment between rows. Suppose the parameter is set to 50 mm, the array will show as below:

![Rows mismatch diagram]

**Columns mismatch:** Defaulted as 0, indicating the misalignment between columns. Suppose the parameter is set to 50 mm, the array will show as below:

![Columns mismatch diagram]
**Rows Mirror:** To mirror the data of even rows according to the configured mirror axis. Suppose Y is checked for the parameter, the array will show as below:

![Rows Mirror Diagram](image)

**Columns Mirror:** To mirror the data of even cols according to the configured mirror axis. Suppose Y is checked for the parameter, the array will show as below:

![Columns Mirror Diagram](image)
Through configuration of the parameters above, arrays can be transformed to the way that saves the most materials. Taking the graphics as an example, the currently configured working area is 1000*800mm, and the defaulted rows and columns are 7 and 6, the array can be set as follows to save the most materials.

The figure above shows the most economical way with 56 graphics (144*120mm) placed and parameters set as: 8 rows, 7 columns, -9.5mm column distance, and Y as the mirror axis.
To scatter:

- Select the arrayed graphics, and click “Modify (M)” -> “Scatter” in the main menu or the “Scatter” item in the right-click menu or click \(\text{scatter}\) in the toolbar to scatter the array.

Note

Now we can use the shortcut key to adjust the row/columns interval and row/columns mismatch.

At first, user must choose the array graphic:
1) Press the key A and D to adjust the row interval;
2) Press the key W and S to adjust the columns mismatch;
3) Press the key SHIFT+ A/D to adjust the row mismatch;
4) Press the key SHIFT+W/S to adjust the columns interval;
5) Press the key F to set the distance to adjust the row/columns interval and row/columns mismatch, default value is 1mm;

Fig.2-242 Before scattering
To cancel the array:

- Select the arrayed graphics, and click the “Cancel” item in the right-click menu to cancel the array.

![After scattering](image1)

![Before cancellation](image2)
The dual laser heads carry out processing after the distance between two laser heads is automatically worked out according to the column number of the array. After array conversion, the figures may not fully fill the area due to the working area of machine, causing a serious waste. The system provides leftover conversion feature for users to save materials.

Warning

Only one array graph is allowed in one document.
About the application of leftover, please refer to 3.2.

### 2.2.4.17 Convert to Light Guide

This software supports special drawing functions for light guide processing, please refer to 3.1.

### 2.2.4.18 Find Overlap Line

Select “Modify” → “Find overlap line” in the main menu, or press “Ctrl+F” to pop up the find overlap line dialog box:
Set the precision at the dialog box, if the distance between two lines is less than the precision, shows overlap.

Press F4 to find overlap line quickly.

Find overlap line only support to find curve, not support to find rectangle, regular polygon, ellipse, Bezier, etc. but they can be found after convert to curve as follow:
2.2.4.19 Catch Edge

Import a BMP bitmap file, right click mouse to pop up the following menu, select catch edge:

<table>
<thead>
<tr>
<th>Catch Edge (Q)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete (Esc)</td>
<td>Del</td>
</tr>
<tr>
<td>Copy (C)</td>
<td>CRTL+C</td>
</tr>
<tr>
<td>Cut (X)</td>
<td>CRTL+X</td>
</tr>
<tr>
<td>Clone (F)</td>
<td>CRTL+F</td>
</tr>
<tr>
<td>Mirror (M)</td>
<td></td>
</tr>
<tr>
<td>Convert Array (A)</td>
<td></td>
</tr>
<tr>
<td>Link Line (L)</td>
<td></td>
</tr>
<tr>
<td>Find Overlap line (Q)</td>
<td>CRTL+F</td>
</tr>
<tr>
<td>Snap Graph (F)</td>
<td></td>
</tr>
</tbody>
</table>

Catch edge dialog box pops up as follow:

Fig.2-251 Left is bitmap, right is catching outline graph
When move the mouse to the corner of the red pickup box, showing the double-headed arrow, press and hold the left button to pulling the border to adjust size; when the mouse is over the pickup box and showing the cross arrow, press and hold the left button to drag the pickup box, you can adjust pickup box location.

The noise threshold is a critical value that divided picture in black and white boundaries, gray scale grading range is 0 to 255. Take a threshold, such as 128, it is black when less than this value and it is white when greater than this value; this software threshold parameter adjustment principle is also similar to this theory.

- **High noise threshold**: to remove most of the interference noise;
- **Low noise threshold**: another parameters of removing interference noise, you can remove the noise in a small area to fine-tune;
- **Granule threshold**: adjusting the parameters of the feature points, the greater the value is, the less feature point;
- **Fitting precision**: adjust the fitting precision of the contour, the greater the value is, the more smooth the contour and the much similar the contour;

The effect is as follow after click “OK”:

![Drag away the bitmap; you can see its outline:](image)
2.2.5 Switch

2.2.5.1 Move

This can be done by mouse, or by setting the parameters in switching dialogue box.

- Drag mouse to move

The software allows users to use mouse to modify the figure directly. It is convenient and quick to operate. Draw a graphics, such as rectangle, move the cursor to cross mark in the center of rectangle when it will become a cross arrow sign, press and hold the left key to move the figure, and then the following interface shows up:

![Fig.2-254](image)

- Use “switch” to move

Click “Modify”→“Switch” in the menu bar, click button, and a dialogue box will show up as follows:
Position:

Show current "horz (mm)" and "vertical (mm)" values when tick it, it is in the relative position of the reference point at the offset value, i.e. the relative coordinate values.

Show the current “horz (mm)” and “vertical (mm)” values are the current reference point need to move the coordinates when not tick it, that is the absolute coordinate values.

Reference point:

This parameter is mainly represented that calculate the offset amount by the coordinate value of that point when moving.

The 9 positions of enclosing rectangle of graphics are center, upper left, left side, bottom left, bottom side, bottom right, right side, and upper right, respectively.

Horz (mm): refer to the position at X axis

Relatively position is selected, the value defaults to 0, the relative offset of reference point is 0. When the value is not 0, the graph will move according to specified offset and positive and negative direction which relative to the current reference point.

Relatively position is not selected, the value defaults to the value of the actual coordinates of the reference point. When the value changes, it indicates that the reference point of the graph will move to the current setting coordinates.

Vert(mm): consult to the parameter of horz.
Apply to copy object: Apply the parameters set above to the copy object of this graphics.

Apply: Apply the parameters set above to the selected graphics.

Press direction key to move

Pitch on graph, press up/ down/ left/ right to move the graph, moving every time of system default is 1mm. Press shift +up/ down/ left/ down to move 10mm every time.

Relatively position:

Unchecked: The value set in “Position” is the absolute position in the working area.

Checked: Move the figure a distance correspondingly to a certain position of enclosing rectangle of graphics.

If relative position is set as center, when you click “Apply” button, the figure will be moved to the center a certain distance, which is set in “Position”.

2.2.5.2 Rotate

Rotation can be done by mouse, or by setting the parameters in switching dialogue box.

◆ When the graphics is selected, click it again to enter the following state:

![Compound bending arrow](Fig.2-257)

Move the cursor to the compound bending arrow (any corner of the four corners), press and hold the left key of mouse to move and rotate the figure.

![Fig.2-258](Image)

User can also move the rotation center, and the figure will rotate around the rotation center after that. When rotating, the center will show as ![Rotation center](Fig.2-259).
Click “Modify” -> “Switch” in the menu bar, click button, and a dialogue box will show up as follows:

**Fig.2-260**

- **Angle**: Set the rotation angle of graphics.
- **X (mm)**: refer to the position at X axis
- **Y (mm)**: refer to the position at Y axis
- **Relatively center**:
  - Unchecked: The value set in “Position” is the absolute position in the working area.
  - Checked: Rotate the figure at an angle correspondingly to a certain position of enclosing rectangle of graphics.

  The 9 positions of enclosing rectangle of graphics are center, upper left, left side, bottom left, bottom side, bottom right, right side, and upper right, respectively. If relative position is set as center, when you click “Apply” button, the figure will be rotated at a certain angle around the center. This angle is set in the above parameters.

- **Apply to copy object**: Apply the parameters set above to the copy object of this graphics.
- **Apply**: Apply the parameters set above to the selected graphics.

- **Two-position rotating**

  Selected the graphics which is need to do the rotation, and right clicked the menu “Two-position rotating” or press the shortcut key “CTRL+R” to switch this mode.
At first, user need to choose the first point of the selected graphics, and this point as the rotation center.

Press the left mouse button to select

Choose the second point of the selected graphics.
Fig. 2-263 Choose the second point

After choose the second point, then the angle of the line relative to the horizontal line would be calculated, and rotate the graphics automatically according the angle.

Note

In the two-position rotating mode, user can only choose the point which is the node of the selected graphics.

2.2.5.3 Mirror

- Select the graphics, click “mirror” in the “modify” of main menu or right click the mouse to select “Mirror (M)”: 

The dialogue box will pop up:
**X Mirror**: Tick off this item to mirror the object horizontally basing on Y axis

![After the X mirror](image)

**Y Mirror**: Tick off this item to mirror the object vertically basing on X axis

![After the Y mirror](image)

Note: The above mirror operations are done on the condition that the graphics is selected. If the graphics is not selected, it is mirrored basing on the central line of working area as shown below:
Fig.2-269

- Use “switch” to mirror:

Click “view” → “switch” in the main menu, then click button to enter parameter interface as follow:

Fig.2-270

- Click this button to mirror the selected graphics basing on X direction.

- Click this button to mirror the selected graphics basing on Y direction.

- That point is the reference point when mirror.

2.2.5.4 Stretch

Stretching operation can be done by mouse, or by setting the parameters in switching dialogue box.

 Still take a rectangle as an example:
Move the cursor to the black spot around the rectangle when it will become an arrow mark, you can then press and hold the left key to stretch the figure.

**Note**
Press and hold “Ctrl” key can stretch with geometric proportion.

**Upper right switching:** Switch the figure towards the upper right

**Right switching:** Switch the figure rightwards

**Bottom right switching:** Switch the figure towards the bottom right

**Bottom switching:** Switch the figure downwards

**Bottom left switching:** Switch the figure towards the bottom left

**Left switching:** Switch the figure leftwards

**Upper left switching:** Switch the figure towards the upper left

◆ Click “Modify” → ”Switch” in the menu bar, click the button, a dialogue box will show up as follows:
Size:

**X/Y (mm):** the length/width of current selected graphics. The least size is 0.1mm.

- Set the number of X/Y without changing by the geometric proportion.
- Press it, the number of XY will change by the geometric proportion, the Y number will change when modify X number.
- These options are the reference sides when switching.

### 2.2.5.5 Shear

Shearing can be done by mouse, or by setting the parameters in switching dialogue box.

- When the graphics is selected, click it again to enter the following state:

  ![Bi-directional straight arrow](image)

  **Fig.2-273**

  Move the cursor to the bi-directional straight arrow (any side of the four sides), press and hold the left key of mouse to move and shear mapping the figure.
Fig. 2-274 Up-down shear

Fig. 2-275 Left-right shear

◆ Click “Modify” –> “Switch” in the menu bar, click button to enter the parameter interface as follows:

Fig. 2-276

**Horz:** refer to the degree of shear at the horizontal direction.

**Vert:** refer to the degree of shear at the vertical direction.

- - - : Current reference side when stretching, this side of selected point would not stretch.
2.2.6 Layer

Layer can be taken as a kind of processing technology. A layer is equivalent to a processing technology. There are several kinds of processing parameters in a layer.

For example in a figure, some places need to be cut deeper and some places need to be cut shallower, this can be done easily with the help of layer settings.

As many as 256 layers are supported. Layer list, layer parameter and work parameter setting area are included.

2.2.6.1 Layer List

Layer can be taken as a kind of processing technology. A layer is equivalent to a processing technology. There are several kinds of processing parameters in a layer.

For example in a figure, some places need to be cut deeper and some places need to be cut shallower, this can be done easily with the help of layer settings.

As many as 256 layers are supported. Layer list, layer parameter and work parameter setting area are included.

2.2.6.1 Layer List

As many as 256 layers are supported. In the layer list, there are items like ID, Color, Priority, process, and visible.

In the layer list, the blue color indicates the checked layer, and the gray color indicates the current default layer. When drafting the figure, the figure is at the current default layer.

Color: Color of the layer, click this item to pop up dialogue box of color setting, user can choose any color to set it as the layer color:
Priority: Set the processing sequence of current layer from grade 1~256. Least grade is the highest priority, and grade 256 is the lowest priority.

Process: Set whether the figure data of the current layer is involved in the processing.

Visible: Set whether the figure data of the current layer is displayed in the drawing area

Select a layer in the layer list and right click the mouse, a menu will pop up as follows:

- Apply to pick object: after click this item, switch the layer number of selected object in the current drawing area to opposite layer ID number of current right click point.
- Apply this layer to all layers: after click this item, system will copy the layer parameters of current right click point to other layers.
- Set default pen: If this option is selected, all figures drafted in the drawing area belong to this layer.
- Parameter library: parameter library is used to save the current parameter which user set, please refer to next section:

Warm: The relation between layer process and graph process:

- When process of layer parameter setting “no”, no matter how to set the process of graph, all graphics of this layer are not processing.
- When process of layer parameter setting “yes”, if the process of graph setting “no”, the current graph will not process.
- When process of layer parameter setting “yes”, if the process of graph setting “yes”, the current graph will process.
2.2.6.2 Parameter Library

- Save layer parameter: save current process parameter to a new file, current layer parameter file can be changed.
- Delete select parameter: delete the selected parameter file of current list.
- Apply to default: revert the process parameter of current layer to default parameter (the primitive parameter)
- Load: click this button to load all the parameter of current selected file into process parameter of current layer. At this moment, “parameter name” will show current parameter file name.

2.2.6.3 Layer Parameters

Layer name: Each layer has the exclusive number, cannot be modified.

Processing media: base on different users, the processing media can be selected. When choose laser to process, this parameter will be set “laser head”. When choose pen to process, this parameter will be set “pen”.

Only support 3rd controller.

2.2.6.4 Work Parameters

- Work parameters of No.1.1 controller.
**Work Parameter**

| Work Vel (mm/ | 200.00 |
| Min. Power (%) | 10.00 |
| Max. Power (%) | 20.00 |

Fig.2-283

**Work vel**: Set the speed of single-axis motion when the machine is working

**Min. power(%)**: The minimal value of laser when processing (0~100%)

**Max. power (%)**: The maximum value of laser when processing (0~100%)

The maximum light intensity should always larger or equal to the minimal light intensity. In case of the similar speed, the larger the light intensity is, the deeper the engraving would be.

◆ work para of Yueming Third Controller

<table>
<thead>
<tr>
<th>Work Para</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Power (%) 30.00</td>
</tr>
<tr>
<td>Corner Power 20.00</td>
</tr>
<tr>
<td>Work Vel (mm/ 80.000</td>
</tr>
<tr>
<td>Work Acc (mm/ 800.000</td>
</tr>
</tbody>
</table>

Fig.2-284

**Work power**: Set the amount of laser energy during the processing

**Corner power**: Set the minimal (cornering) edge lining energy when cutting

**Work vel**: Set the speed of cutting

**Work acc**: Set the acceleration during the processing

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The light intensity will influence the depth of engraving, which is also related to the power of laser, model of main board, speed value and DPI settings in parameter settings.</td>
</tr>
<tr>
<td>• If the power is set as the same, the faster the speed is, the shallower the engraving would be. On the contrary, the slower the speed is, the deeper the engraving would be.</td>
</tr>
<tr>
<td>• If the speed is set as the same, the greater the power is, the deeper the engraving would be. On the contrary, the smaller the power is, the shallower the engraving would be.</td>
</tr>
</tbody>
</table>

2.2.7 Virtual Printer Input

Data (vector diagram, bitmap, text, etc.) from all kinds of software (such as CorelDraw, and AutoCAD) can be transferred to SmartCarve with the help of printing function of the software via the Yueming Virtual Printer. It is simple and quick, getting rid of the format conversion and import operations. Please refer to virtual print input of chapter3 about the particular method.
2.2.8 Export

2.2.8.1 Net Transfer

Net transfer only support No.3 controller. Application of network transmission function:

After saving the drafted figure as *.ymd file or exporting the parameters as *.ini file, click the network transmission button in toolbar, and the following dialogue box will pop up:

Steps to download files to machine:

- Link the network. If the network is successfully linked, network Linked information will be shown in the network status area.
- Set the IP address. It is default as “192.168.1.8”. The IP of machine should also be set as this value.
- Change the file catalog in “Local Dir”. In the left file list, there show the figure data files and parameter files.
- Select the file(s) and click the right double-headed arrow to download them to machine.

Steps to upload files to computer:

- After Linking to the network, the current files on machine will be shown at the right file list.
- Select a file and click the left double-headed arrow to upload it to the current catalog on the computer.
2.2.8.2 Carve Output

When all figure data are ready, it is time to export them to machine for operation. Click in the toolbar, or right click the mouse in drawing area. A dialogue box will show up as follows:

![Carve out dialogue box]

**Clone row, clone column:**

Figure data can be exported in multi-line or multi-column way. The default is 1 line and 1 column.

**Row interval (mm), Column interval (mm):**

Set the spacing between figures when exporting figures with several lines and columns.

**Estimated time:**

It is the time estimated to process the current graphics according to the customized processing speed.

**Feeding count:**

It is applicable to automatic feeding equipment. The default value is 0, and the machine cuts for one time. Cutting times of machine=Feeding times+1.

**Feed length (mm):**

It is the length of feeding at one time, user can set a value as required.

**Origin mode:**

![Origin mode options]

Fig.2-287
**Anchor point:** It is a positioning point previously set, to which the machine will return and start engraving and cutting. The origin of coordinates in the drawing area is corresponding to the set positioning point of machine.

**Current point:** The machine will start engraving and cutting from the current position of laser head. The origin of coordinates in the drawing area is corresponding to the current position of laser head.

As shown in the following diagram:

![Diagram](image)

**Fig.2-288** SmartCarve4 drawing area

The final output effects of above options are as follows:

![Output examples](image)

**Fig.2-289**

**Rotate diameter:** To set the column diameter for engraving, used for setting the engraving machine.
**Cut edge:** Allow you to set the power for cutting edge. The machine will use the value to trim frames.

**Vel:** To set the speed for cutting edge.

**Power:** to set the power for trimming.

**Carver Out:**

Start to export to the machine. When you click the OK button, there will be a progress indication in the status bar of the software.

![Fig.2-290](image)

**Cut Edge:** Start task for cutting edge.

**Cancel:** Exit

### 2.2.8.3 Jog Control

Jog control is used to control No.1.1 controller. This function is effective when the machine is No.1.1 controller. Click **button in the toolbar or press “CTRL+H” or click “Jog Control” in the tools menu as follow:

![Fig.2-291](image)

A dialog box will pop up:
Fig. 2-292

- **Axis**: select the hand move axis, X, Y, Z, U, V, W and material axis.
- **Relatively**: click relatively, setting the relatively offset, the default is 0, the unit is mm.
- **Absolutely**: click absolutely, setting the end position, the default is 0, the unit is mm.
- **Power**: tick “laser on”, setting the laser on power, the default is 0, the unit is %.
- **Speed**: setting the move speed, the default is 0, the unit is mm/s.

Click “run” to take hand move after setting.

### 2.2.8.4 Cancel Filter Operation

The feature is only available after the filter has been enabled.

When an operation takes a long time, the software enters the suspended state, resulting in failure to perform any other operation unless the current operation is complete. Therefore, the system provides such a feature that is designed to solve the problem.

If users do not want to proceed upon the operation of some filter, just click the button to quit.

The system only allows one filter to work at the same time for the moment.

Filter operation includes Import File (like vector diagram and bitmap), Printer Input, Export (plt, ymd, oux, etc.).
2.2.8.5 Machine Parameter Setting

Please refer to its software manual about the correlative content of machine type of controller.

No.1.1: please refer to “HAN'S YM User Manual of NO.1.1 Control System”
No.3: please refer to “HAN'S YM User Manual of NO.3 Control System”
No.4: please refer to “HAN'S YM User Manual of NO.4 Control System”
Auto feeding: please refer to “Han's YM User Manual of Nest Cutting”
Vision system type: “HAN'S YM User Manual of Vision System”

2.2.8.6 Path Simulation

If you want to simulate the processing of figure on computer, you can click in toolbar, and the track simulation dialogue box will pop up:

During the simulation of figure processing, users can also perform the following operations on the keyboard:

Right arrow key: increase the idle travel speed (the white part in the picture)
Left arrow key: decrease the idle travel speed (the white part in the picture)
Up arrow key: increase the processing speed (the green part in the picture)
Down arrow key: decrease the processing speed (the green part in the picture)
Space key: Pause or keep on the track stimulation operation
R key: Restart the track stimulation
ESC: Exit Engraving output
Cut length (mm): show the info about cut path length.
Space length (mm): show the info about space path length.

2.2.9 Config

Click “Tools” → “Config” in the main menu or click button:

![Fig.2-294](image)

Open the config interface, the config as follow:

2.2.9.1 General

- **Unit type**: the unit type when show coordinates and distance. Only support mm now.
- **Paste X (mm)**: the horizontal offset between paste figure and primitive figure.

![Fig.2-295](image)
- Paste Y (mm): the vertical offset between paste figure and primitive figure.
- Show grid: tick this item, grid will show in the drawing area.
- Grid space: setting the space between of grid.
- Redo/undo grade: redo or undo the operation, the higher grade is, the larger the memory consumption. Please set grade properly.
- Optimize path when exporting: When this option is ticked, the system will automatically optimize the processing path to output processing, otherwise output according to original path or need to manually to select path optimization to optimize path.

2.2.9.2 Color

User can set the color of interface as follow:

- **Background**: the background color of drawing area, click background box, the color chosen dialog box will pop up as follow:
Select the background color, then click “ok” back to color setting main interface, then click “ok” to finished.

- **Workspace**: setting the color of workspace.
- **Grid**: setting the color of grid.
- **Ruler**: setting the color of grid.

In addition, in “View (V)” option in main menu:

![View Menu](image)

User can set whether to show grid and scale in the drawing area.
2.2.9.3 Workspace

- **Show workspace**: tick this item, show the working area (the rectangle box with shadow)
- **Show cross line**: tick this item, show the cross line of center (origin coordinate line, the red dashed)
- **Width (mm)**: Refer to the width of working area, or the working range of machine at X-axis direction.
- **Height (mm)**: Refer to the height of working area, or the working range of machine at Y-axis direction.

User can regulate the width and height according to the processing scale of carving machine. Make the CMA1390 for example; user could fill in 1300 in width and 900 in height in the config dialogue box (unit in mm). The default is 1000mm*800mm.

2.2.9.4 AutoSave

AutoSave is used to save the figure which users draw automatically, the interface as follow:
Fig. 2-301

- **Auto Save**: AutoSave is effective when tick this item.
- **Time (minutes)**: the time of auto save, save current data to file “auto save.smc” in install directory at specified time space. When close the software singularly, user can open this saved file to resume data after restart the software.

**2.2.9.5 Move/Rotate**

User can move or rotate the figure through the keyboard, setting move or rotate distance.

Fig. 2-302

- **Nudge distance**: press Alt+ up/down/left/right key of keyboard to move the selected figure, figure move every time you press the key, the unit is mm.
- **Big nudge scale**: press shift +up/down/left/right key to quicken the speed of moving figure. Base on nudge distance, multiply a coefficient.
- Rotate angle: press ctrl+ left/right key to rotate the selected figure, figure rotate every time you press the key, the unit is degree.

- Max num: when the select graph num is exceed this num, it’s only show the outline when do stretch or rotate operation. When the select graph num is lower this num, it will show the operation at real-time.

Note: Please set the right max num base on the computer instance, if set too big, it will affect the show and deal speed when operating.

2.2.9.6 Precision

Precision is used to set the precision standard when dealing figure, different setting lead the different figure dealing effect. The interface as follow:

- Precision for conversion: When it is smaller than a certain value, the graphics can be perforated. The value, namely the precision for conversion of small graphics to perforated graphics, ranges from 10 to 10000 microns. When external rectangle of graph is smaller than this parameter value, it can be converted to drill.

- Small graph size: Set the standard maximum value of the small graph size, the unit is mm, the parameter range: 0.01 to 10mm.

- Curve precision: To set the curve precision for the software. The system default is 0.2, the unit is mm.
Fig. 2-304 The curve precision of left is 2mm, the right is 10mm

- **Link line precision**: To set the link line precision for software. The system default is 0.2, the unit is mm.

- **Combine lines while import the file**: the software can link the lines which is below the link line precision during import the vector file.

- **Smooth line**: precision and velocity on both sides of the sliding block directions. Slider toward to right, the precision of software is not high when output graphics processing, which may lead to some arc shape when output; Slider toward to left, the precision of software will higher, but the processing speed will reducing; shown in the following figure:

Fig. 2-305 The left one is precision processing state, the right one is velocity processing state

2.2.9.7 User Manager

User manager is used to manage the purview, three classifications: administrator, designer and worker, the interface as follow:
Enable user: tick this item, user manager takes effect.

Choose user and set the password. Click “modify password” button, the dialog box pop up as follow:

Enter the new password in the password box and enter it again in the confirm password box, and then click “ok” to finish.

2.2.9.8 Backlash

This parameter only needs to be set in the No.1 controller, set the backlash of cutting and engraving process, backlash setting interface as shown below:

The backlash is determined by the mechanical accuracy of the machine and the response speed of the laser. The movement of the machine is driven by the electromotor to drive the motor belt. When processing, since there is a certain degree of activity gap between the engagement of the tooth of the belt and the gear. As shown below, when clockwise, and reversal of the transformation occurs, the activity gap will affect the efficiency of the transmission, lag the transmission, then you need to set the backlash to resolve the problem of the machine's transmission lag.
When there is an active gap, the processing will appear as shown below:

![Figure 2-309](image)

**Fig.2-309** When there is an active gap, the processing will appear as shown below:

**Left is the expectation of processing, the right is processing effect of transmission lag**

### 2.2.10 Language

The available languages are Chinese (Simplified), Chinese (Traditional), and English (US). To add a language, add the corresponding XML file into the “Language Settings”.

![Language Setting](image)

**Fig.2-311** At above figure, tick “English(US)” means that the current language is English.

#### 2.2.10.1 Language Setting

Language setting supports a language loading manner to user. It will pop up a dialog box as follow:
The left box shows the language file of the current system, allowing users to export the language file of the current system to anywhere on the disk.

You can find the language file of the disk selected from the right box and load it into the system list. A new language file will be added.

Click the button and choose a disk list; the system will automatically search for the language file in the current list. It will display it in the list as follows:

If there is a Czech file in the disk list, select it and click the button; this file will be loaded into the system list as follows:
Click “exit” to exit “language setting” interface.

A new language show in “tool” → “language” as follow:

2.2.10.2 Translate Tool

Please refer to 3.4 about the translate tool and its language file making.
Chapter 3 Application Example

3.1 Drawing Light Guide Graphics

How to draw:

1) Open software, draw a closed vector graph (make a rectangle for example):

![Fig.3-1](image)

2) Pitch on the rectangle and right click the mouse, then click “convert to light guide1” or “convert to light guide” at the right click menu.

![Fig.3-2](image)

The setting interface of light guide will pop up as follow:
Fig. 3-3  Light guide 1
SmartCarve 4 can create four modes for the light guide industry: line mode, sweep mode, grid mode and circle mode. It can create arbitrary light guide graphics; design the graphics which enter light by one side, double sides, and all sides. The explain of four modes of light guide are as follow:

1) **Line**: The export graphics is speck; we can adjust the width of speck. The height of speck decided by the line of laser head. Working high speed, process speck uniformly and the amount of producing data are small. It is apply to process the speck light guide of large area. The quality of speck depends on the stability of laser.

2) **Sweep**: Also named carve, the export graphics is speck. The size, width and height of speck can be adjusted by software. Its working manner is similar to fill carve. All specks carved by laser repeatedly. This manner is inefficient, but high quality and good steady. Its DPI can be adjusted and produce the circle of arbitrary size. It is apply to process the speck light guide of small area.

3) **Grid**: The export graphics is grid line or the straight line of X/Y direction. The process manner is drawing line by laser head. This manner process with high speed, but the data amount of graphics is small. The grid form can be designed by users. The quality of drawing line depends on the stability of laser. It is apply to process the grid light guide of arbitrary area.

4) **Circle**: Output graphics is circle mode, the dot width can be adjusted, the dot height is decided by the distance of laser head out of focus; this mode supports only primitive processing of regular polygon and a perfect circle.

### 3.1.1 Light Guide 1

#### 3.1.1.1 Line

The height of speck is decided by the distance between laser head and speck. The software can only set the speck change of width (height) and grads. The parameters setting as follow:

- **Speck width (mm)**: setting the reference height of speck.
- **Width grads (mm)**: setting the width’s gradual change value row by row or column by column of speck. When setting above zero, the width increases long by degrees. When setting below zero, the width decreases short by degrees. When setting row grads, the width of speck changes row by row. When setting column grads, the width of speck changes column by column.
- **Up row interval (mm)**: setting the reference distance between row and row above the speck of horizontal reference line.
- **Up row grads (mm)**: setting the gradual change value of row distance above the speck of horizontal reference line.
- **Down row interval (mm)**: setting the reference distance between row and row below the speck of horizontal reference line.
- **Down row grads (mm)**: setting the gradual change value of row distance below the speck of horizontal reference line.
- **Left column interval (mm)**: setting the reference distance between column and column of the vertical reference line at the left speck.
**Left column grads (mm):** setting the gradual change value of speck column distance at the left vertical reference line.

**Right column interval (mm):** setting the reference distance between column and column of the vertical reference line at the right speck.

**Right column grads (mm):** setting the gradual change value of speck column distance at the right vertical reference line.

**Center offset X/Y (mm):** setting the offset of reference line, the center line of light guide graphics defaulted as reference line. Setting the offset of X direction to change the position of vertical reference line, above zero or not means offset left or right. Setting the offset of Y direction to change the position of horizontal reference line, above zero or not means offset up or down.

**Row mismatch:** tick this item, the speck between row and row array by mismatching. The mismatch distance is half of column distance.

**Column mismatch:** tick this item, the speck between column and column array by mismatching. The mismatch distance is half of column distance.

---

**Fig. 3-5**  
Line: lighting from left side and right side
Fig. 3-6  Line: lighting from right side

Fig. 3-7  Line: lighting from up and down
Fig. 3-8  Line: lighting from down

Fig. 3-9  Line: unsymmetrical lighting from left and right
3.1.1.2 Sweep

Sweep can set the speck to heavens basing on line. The specks carve by laser head. The parameters as follow:

**Direction**: setting the direction, allow four directions: X double, X single, Y double, Y single. Generally, set X double.

**Scan precision(dpi)**: setting the carve density of speck sweeping, the unit is column/every inch.

**Speck height(mm)**: setting the referenced height value of speck.

**Height grads(mm)**: setting the height gradual change value of speck.

Other parameters are the same as line.
Fig. 3-11  Sweep: lighting from up and down

Fig. 3-12  Sweep: lighting from left and right
Fig. 3-13  Sweep: unsymmetrical lighting from up and down

Fig. 3-14  Sweep: unsymmetrical lighting from left and right
Fig. 3-15  Sweep: lighting from down side

Fig. 3-16  Sweep: lighting from right side
Fig. 3-17  Sweep: lighting from right side2

Fig. 3-18  Sweep: lighting from right side3
3.1.1.3 Grid

If the grid is drawing line mode, the correlative parameters are invalidation. The correlative parameters of gridding line as follow:

- X direction enable: drawing the beeline of X direction.
- Y direction enable: drawing the beeline of Y direction.

Enable X direction and Y direction at the same time is gridding line, other parameters setting of gridding line is as the same as speck mode, repeat no more.
Fig. 3-20 Grid: transverse lighting from up and down

Fig. 3-21 Grid: vertical lighting from left and right
Fig. 3-22 Grid: gridding line lighting from up and down

Fig. 3-23 Grid: gridding line lighting from left side
Fig. 3-24 Grid: gridding line lighting from up side

Fig. 3-25 Grid: unsymmetrical lighting from up and down
3.1.1.4 Circle

Circle mode, dot output is according to the circular array, can set the width of the dot, interval and annular array spacing parameters that are as follows:

✧ Speck: set the base width of speck;
✧ Blank: set the same ring on the spacing distance between dots;
✧ Interval: set the distance between the annular array;

Take round for example:

Circle mode is the feature of the light source of light guide from light-in at all sides, the distance light source far place, need to arrange is close to launch the point light source, or arrange sparse point.
Due to the circle array, sometimes center will appear hollow phenomenon and bring about the light source cannot be reflected at the center position, so at this time should be add a perforated graphics in the center position.

### 3.1.1.5 Drawing Anomalistic Light Guide

SmartCarve4 create not only the rectangle light guide, but also the anomalistic light guide. Example follows:

1) Polygonal light guide
2) Circular light guide

3) Elliptical light guide
4) Complicated light guide

3.1.2 Light Guide 2

The light guide 2 parameter setting interface is graphical, intuitive, and can achieve an abundant set of parameters change.

- Y base interval: adjust the interval between row and row of Y-direction, the range is 0.1 ~ 10mm;
- X base interval: adjust the interval between column and column of the X direction, the range is 0.1 ~ 10mm;
- X base size: adjust the specified width dimension of the dots in the X direction above the X-area segments, the size is 0.1 to 4mm;
- Y base size: adjust the designated height dimension of the dots in the Y direction above the Y-area segments, the size is 0.1 to 4mm;
- row mismatch: tick it, the dots between row and row mismatch array, mismatch distance is half the interval for the column;
- column mismatch: the dots between column and column mismatch array, mismatch distance is half the interval for the row;

Basic operations:
Select graph, right-click to select the light guide 2, pop-up setting dialog box, you can set the corresponding parameters. As shown below:

Fig.3-32  Node parameter adjusted method 1
As shown below, you can double left click on one point of regulating line to increase adjustment point, if you want to cancel the node; the same double-click the node to cancel.

In addition to adjusting the baseline, you can also through regional adjustment to achieve the dots adjustment of various areas, as follows:
A total of nine regions, each regional value range: 50 to 200. Example as shown below: set the maximum as 200 of the two regional dots at the left bottom corner, to achieve effects of regional changes.

Areas adjust: you can set the dot size of the local area; the range is 50 to 200.

3.1.2.1 Line

Take rectangle for example, size is 100*90, adjusted through node: Light in at left and right sides, adjust the intermediate nodes value to 1 of the X base interval, Y mismatch, and the other defaults:
Fig.3-37  Light-in at left and right sides

Fig.3-38  Light-in at right side
Fig. 3-39  Light-in at upside and underside

Fig. 3-40  Light-in at upside
Fig. 3-41  Light-in all sides + area adjustment

Fig. 3-42  The light-in is asymmetric at left and right sides
Fig. 3-43 The light-in is asymmetric at upside and underside

Fig. 3-44 The light-in is asymmetric at all sides
3.1.2.2 Sweep

Fig.3-45  Light-in at left and right sides

Fig.3-46  Light-in at right side
Fig. 3-47  Light-in at upside and underside

Fig. 3-48  Light-in at underside
Fig. 3-49  Light-in at all sides

Fig. 3-50  The light-in is asymmetric at all sides
3.1.2.3 Grid

Fig. 3-51  Horizontal line: light-in at upside and underside
Fig. 3-52  Vertical line: light-in at left and right sides

Fig. 3-53  Grid line: light-in at upside and underside
Fig. 3-54 Light-in at right side

Fig. 3-55 The light-in is asymmetric at upside and underside
3.1.2.4 Circle

Base size: Set the base width of dots;
Base space: Set the interval distance between dots at the same the circle;
Base interval: Set the distance between the circle array;

3.1.3 Support and Optimize GTools

Use light guide drawing software “GTools” to create the speck or line figure which more specialty and strong function. But the created DXF files larger in widely( over 30M). SmartCarve4 optimizes the data aim at these figure files. Optimize speed and process path at read, show and edit files.
3.1.4 Carve output

Presently, light guide figure which draw through SmartCarve 4 can only use No.1.1 controller to process. The software has optimized the path of light guide figure, users do not need to optimize it in addition. It can use carve output directly or created OUX files, then insert No.1.1 controller to process. The default memory space of No.1.1 controller is 32M. Actually, the maximal file transmit through U disk or carve output is 16M. Aim at the instance which light guide figure may create the biggish file, users can require to make the controller with higher capability (the most general memory is 128M, the most memory of carve output is 32M, transmit by U disk is 96M.)

Fig.3-58 The speck figure of 600m × 600m lighting from three sides (created by GTools, the opened time less than 10second)
3.2 Multi-laser process

No.1.1 controller can achieve cutting large format materials functions by multi-laser head processing, can effectively improve the processing efficiency of machine.

Suppose that the width of current working space is 1000mm, height is 800mm, and with 4 laser heads, it can set the distance of 250mm.

Fig.3-59

Then drawing interface is shown as below, it has been divided into four parts, it is only necessary to draw in a region close to the origin of coordinates, the other three areas will automatically output the processing according to this area:

Fig.3-60
3.3 The Application of Array and Leftover

To convert the leftover:

- A graphics after convert array as follow:

It can be found that the figures do not fully fill the area, i.e., there is still blank in the left side of working area. Now we can add graphics in the blank, as the following picture shows.
After drawing, select all drafted figures or one by one, and click “Convert Leftover” in the right-click menu, as the following picture shows:

After conversion, all the drafted graphics are added to the array, as the following picture shows:
Detach Leftover: to detach the leftover in the array.

- Select the arrayed graphics, click “Modify (M)” -> “Dismantle Leftover” or the “Dismantle Leftover” item in the right-click menu.
3.4 Virtual Print

3.4.1 Take CorelDrawX3 as an Example

Now, we will use Windows-XP and CorelDraw X3 to demonstrate.

1) Start CorelDrawX3, draw a figure or import a figure:

Select “Attribute Manager” from “Edit (E)” in the menu bar and the object attribute page will show up:
2) Click “File”→“Print” or press shortcut Ctrl+P, a dialogue box as follows shows up, set “Name (N)” as SmartCarve43 Virtual Printer.

![Print Dialogue Box]

Click “Print” button, switch to SmartCarve4, and the figures drafted in CorelDrawX3 will then be imported directly.
In order to make sure the integrality of printing graphics, we suggest to use CorelDrawX3 or the above edition.

3.4.2 Take AutoCAD2004 as an Example

System: Window XP
Software: Auto CAD2004

A. Start AutoCAD2004, draw a figure or import a figure:
B. Click “File”->“Plot” or press shortcut Ctrl+P, a dialogue box as follows shows up

Fig. 3-73

Select item “Printing device” and change the “Name (N) in “Printer config” to “SmartCarve43 Virtual Printer”.

Select item “Printing setup”, set “Scale” as 1:1 and tick off “Center the plot”. For “Graphic direction”, user can select “Vertical” or “Horizontal” as required. Here it chooses “Vertical”, and click OK to export.

C. Switch to SmartCarve4, and the figures drafted in AutoCAD2004 will then be imported directly.
3.5 Translate Tool

1) Open the LangTool of SmartCarve4:

   Click “Tool” → “Language” → “Translate tool” in the menu of SmartCarve4 or click “Ctrl+T”, as follow:

![Fig.3-76](image)

   - Open reference language bag

2) There are two sides of the translate tool interface. Open the reference language bag at the left side. If take English as example, open en_us.xml.

![Fig.3-77](image)
3) Click “new” button at the right side of language bag tool, create a new language bag. Or click “open” button, open a language bag which need to modify.
4) As above figure, a new language bag can be created, the part between the red quotation marks are blank, users need to translate by yourselves. Double click the one what you want to translate, and then edit it.

5) After edit the language bag of right side, click “save” button to save the language. Attention: the language must be saved at “language” list of “SmartCarve4”.
6) A new language bag has finished by the above steps, restart SmartCarve4, we can see the language which we created at the language menu, it can be transformed directly.

7) If users need to pack the language, please set the language bags to our company, we will pack them all together.
Post

All final right of interpretation of this manual belongs to GD HAN'S YUEMIGN LASER GROUP CO., LTD, we will do our utmost efforts to ensure the accuracy of the contents of this manual. We do not assume any responsibility caused by misspellings and typing errors. Your comments will be highly appreciated.